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Getting started with PSoC™ 4 MCU

About this document
Scope and purpose

This application note introduces you to PSoC™ 4, an Arm” Cortex -M0/MO0+ based programmable system-on-
chip. It helps you explore the PSoC™ 4 architecture and development tools and explains you how to create your
first project using PSoC™ Creator and ModusToolbox™, the development tools for PSoC™ 4; also guides you to
more resources to accelerate in-depth learning about PSoC™ 4.

Intended audience

This application note is intended for engineers new to PSoC™ and ModusToolbox™, and those with experience in
working with embedded microcontrollers.

Associated part family

All PSoC™ 4 parts
Software version

PSoC™ Creator 4.4 SP2 or higher, ModusToolbox™ 3.2 or higher.
More code examples? We heard you.

To access an ever-growing list of PSoC™ PSoC™ 4 code examples using ModusToolbox™, please visit the GitHub
site. You can also explore the PSoC™ video library.
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1 Introduction

1 Introduction

PSoC™4 is a true programmable embedded system-on-chip integrating custom analog and digital peripheral
functions, memory, and an Arm’ Cortex’-MO or Cortex -M0+ microcontroller on a single chip. This type of system
is different from most mixed-signal embedded systems, which use a combination of a microcontroller unit
(MCU) and external analog and digital peripherals. These systems typically require many integrated circuits in
addition to the MCU, such as opamps, ADCs, and Application-specific Integrated Circuit (ASICs).

PSoC™ 4 provides a low-cost alternative to the combination of MCU and external ICs. In addition to reducing
overall system cost, the programmable analog and digital subsystems allow great flexibility, in-field tuning of
the design, and speedy time to market.

The capacitive touch-sensing feature in PSoC™ 4, known as CAPSENSE™, offers unprecedented signal-to-noise
ratio; best-in-class liquid tolerance and a wide variety of sensor types such as buttons, sliders, trackpads, and
proximity sensors. PSoC™ 4 offers a best-in-class current consumption of 150 nA while retaining SRAM,
programmable logic, and the ability to wake up from an interrupt. PSoC™ 4 consumes only 20 nA while
maintaining wakeup capability in its non-retention power mode. The PSoC™ 4 family of devices also contain
PSoC™ 4 Bluetooth® LE, which integrates a Bluetooth® Low Energy radio system. For more details on PSoC™ 4
Bluetooth® LE, see AN91267.

Using this document

The next few pages describe PSoC™ 4 and the advantages of designing with PSoC™, ModusToolbox™, and PSoC™
Creator. Or, you can jump right in and quickly build a simple design in ModusToolbox™ - go to Getting started
with PSoC™ 4 design. If you are using PSoC™ Creator - go to My first PSoC™ 4 design using PSoC™ Creator.
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2 Development ecosystem

2.1 PSoC™ resources

The wealth of information available on the Infineon webpage can help you select the right PSoC™ device and,
additionally, integrate the device into your designs efficiently and effectively. The following is an abbreviated
list for PSoC™ 4:

«  Overview: PSoC™ portfolio
+  Product selectors: PSoC™ 4. In addition, PSoC™ Creator includes a device selection tool.
« Datasheets describe and provide electrical specifications for each family.
« Application notes cover a broad range of topics, from basic to advanced level, and include the following:
- ANB88619: PSoC™ 4 hardware design considerations
- AN73854: Introduction to bootloaders
- AN89610: Arm’ Cortex” code optimization
- AN86233: PSoC™ 4 low-power modes and power reduction techniques
- AN57821: Mixed-signal circuit board layout
- AN89056: PSoC™ 4 - [EC 60730 class B and IEC 61508 SIL Safety Software Library
- ANG64846: Getting started with CAPSENSE™
- AN85951: PSoC™4 and PSoC™ 6 MCU CAPSENSE™ design guide
+  Code examples demonstrate product features and usage

«  Technical reference manuals (TRMs): Provide detailed descriptions of the architecture and registers in each
PSoC™ 4 device family.

+  PSoC™ 4 programming specification provides the information necessary to program PSoC™ 4 nonvolatile
memory.

« Development tools:

- CY8CKIT-040, CYSCKIT-042, CYS8CKIT-044, CYS8CKIT-046, CYSCKIT-042-BLE, CYS8CKIT-045S, and
CY8CKIT-041S-MAX PSoC™ 4 Pioneer kits are easy-to-use and inexpensive development platforms.
These include connectors for Arduino-compatible shields and Digilent Pmod daughter cards.

- CY8CKIT-043, CYSCKIT-145-40XX, CYS8CKIT-147, CYS8CKIT-149, and CYSCPROTO-040T are very low-cost
prototyping platforms for sampling PSoC™ 4 devices.

- CYB8CKIT-040T is a low-cost evaluation kit showing the low power CAPSENSE™, low power wake on
touch and liquid tolerant features of the PSoC™ 4000T device.

- The MiniProg3 or MiniProg4 kit provides an interface for flash programming and debug.

- Integrated Development Environment (IDE): There are two development platforms that can be used for
application development with PSoC™ 4 - ModusToolbox™ and PSoC™ Creator.

- PSoC™4 CAD libraries provide footprint and schematic support for common tools. IBIS models are also
available.

+ Training videos are available in Infineon website on a wide range of topics including the PSoC™ 4101 series

« Infineon community enables connection with fellow PSoC™ developers around the world, 24 hours a day, 7
days a week, and hosts a dedicated PSoC™ 4 MCU community.

2.2 Firmware/application development

There are two development platforms that you can use for application development with PSoC™ 4:

+  ModusToolbox™: This software includes configuration tools, low-level drivers, middleware libraries, and
other packages that enable you to create MCU and wireless applications. All tools run on Windows, macOS,
and Linux. ModusToolbox™ includes an Eclipse IDE, which provides an integrated flow with all the

Application note 4 001-79953 Rev. *Z
2024-02-26


https://www.infineon.com/
https://www.infineon.com/cms/en/product/microcontroller/32-bit-psoc-arm-cortex-microcontroller/
https://www.infineon.com/cms/en/product/microcontroller/32-bit-psoc-arm-cortex-microcontroller/psoc-4-32-bit-arm-cortex-m0-mcu/
https://www.infineon.com/cms/en/design-support/tools/sdk/psoc-software/psoc-creator
https://edit.infineon.com/cms/en/search.html?intc=searchkwr-return&_ga=2.13227895.1357508168.1686477175-1954945834.1669208470#!view=downloads&term=PSOC4&doc_group=Data%20Sheet
https://edit.infineon.com/cms/en/search.html?intc=searchkwr-return&_ga=2.43161701.1357508168.1686477175-1954945834.1669208470#!view=downloads&term=PSOC4&doc_group=Application%20Notes
https://www.infineon.com/AN88619
https://www.infineon.com/AN73854
https://www.infineon.com/AN89610
https://www.infineon.com/AN86233
https://www.infineon.com/AN57821
https://www.infineon.com/AN89056
https://www.infineon.com/AN64846
https://www.infineon.com/AN85951
https://github.com/Infineon/Code-Examples-for-ModusToolbox-Software
https://edit.infineon.com/cms/en/search.html?intc=searchkwr-return&_ga=2.17882233.1357508168.1686477175-1954945834.1669208470#!view=downloads&term=PSOC4&doc_group=Additional%20Technical%20Information
https://www.infineon.com/dgdl/Infineon-AN84858_PSoC4_Programming_Using_an_External_Microcontroller_(HSSP)-ApplicationNotes-v15_00-EN.pdf?fileId=8ac78c8c7cdc391c017d07350eca5867
https://www.infineon.com/cms/en/product/microcontroller/32-bit-psoc-arm-cortex-microcontroller/psoc-4-32-bit-arm-cortex-m0-mcu/?tab=~%27development_tools#!designsupport
https://www.infineon.com/cy8ckit-040
https://www.infineon.com/cy8ckit-042
https://www.infineon.com/cy8ckit-044
https://www.infineon.com/cy8ckit-046
https://www.infineon.com/cy8ckit-042-ble-a
https://www.infineon.com/cy8ckit-045s
https://www.infineon.com/cy8ckit-041s-max
https://www.infineon.com/cy8ckit-043
https://www.infineon.com/cy8ckit-145-40xx
https://www.infineon.com/cy8ckit-147
https://www.infineon.com/cy8ckit-149
https://www.infineon.com/CY8CPROTO-040T
https://www.infineon.com/cy8ckit-040t
https://www.infineon.com/cy8ckit-002
https://www.infineon.com/cy8ckit-005
https://www.infineon.com/cms/en/design-support/tools/sdk/modustoolbox-software/
https://www.infineon.com/cms/en/design-support/tools/sdk/psoc-software/psoc-creator
https://edit.infineon.com/cms/en/search.html?intc=searchkwr-return&_ga=2.17882233.1357508168.1686477175-1954945834.1669208470#!view=downloads&term=PSOC4&doc_group=PCB%20Design%20Data
https://edit.infineon.com/cms/en/search.html?intc=searchkwr-return&_ga=2.17882233.1357508168.1686477175-1954945834.1669208470#!view=downloads&term=PSOC4&doc_group=Simulation%20Models
https://media.infineon.com/
https://media.infineon.com/search/psoctm%20101/2/?sort=display_date
https://community.infineon.com/
https://community.infineon.com/t5/PSoC-4/bd-p/psoc4

o~ _.
Getting started with PSoC™ 4 MCU In fl neon

2 Development ecosystem

ModusToolbox™ tools. Other IDEs such as Visual Studio Code, IAR Embedded Workbench and Arm” MDK
(WVision) are also supported.

ModusToolbox™ software supports stand-alone device and middleware configurators. Use the configurators
to set the configuration of different blocks in the device and generate code that can be used in firmware
development. ModusToolbox™ supports all PSoC™ 6 MCU and the latest PSoC™ 4 MCU devices. Table 1 lists
the supported PSoC™ 4 devices. Infineon recommends you to use ModusToolbox™ for all application
development for supported PSoC™ 4 devices. For more information, see ModusToolbox™ tools package user
guide.

Table 1 List of PSoC™ 4 devices supported in ModusToolbox™

Devices? ModusToolbox™ PSoC™ Creator
PSoC™4000S, PSoC™ 4100S, PSoC™ | Yes Yes

4100S Plus, PSoC™4100S Plus

256K

PSoC™4100S Max, PSoC™4000T Yes No

All other PSoC™ 4 devices No Yes

The libraries and enablement software are available on GitHub.

ModusToolbox™ tools and resources can also be used in the command line. For more information, see the
“ModusToolbox™ build system” section in the ModusToolbox™ tools package user guide.

+ PSoC™Creator: PSoC™ Creator is a free Windows-based IDE. It enables concurrent hardware and firmware
design of PSoC™ 3, PSoC™ 4, PSoC™ 5LP, and PSoC™ 6 MCU systems. Applications are created using
schematic capture and over 150 pre-verified, production-ready peripheral Components.

2.2.1 Installing the ModusToolbox™ tools package

Refer to the ModusToolbox™ tools package installation guide for details.

2,2.2 Choosing an IDE

Figure 1 helps you to choose an appropriate IDE.

1 PSoC™ 4 feature set for complete PSoC™ 4 portfolio.
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New PSoC™ 4 user

Is device
supported in
ModusToolbox™?

No

supported only in
ModusToolbox™?

Do you need Linux or
MacOS

support or use third-party
IDEs such as Visual Studio
ode, IAR, or Arm MDK

Are you inclined towards
using a Graphical Editor for
Design Entry and Code

\ 4 Y

Use PSoC™ Creator Recommended to use Use ModusToolbox™
ModusToolbox™

Figure 1 Choosing an IDE

ModusToolbox™ software, the latest-generation toolset, is supported across Windows, Linux, and macOS
platforms. ModusToolbox™ software supports 3rd-party IDEs, including the Eclipse IDE, Visual Studio Code, Arm”
MDK (uVision), and IAR Embedded Workbench. The tools package includes an implementation for the Eclipse
IDE and Visual Studio Code (VS Code) for your convenience. The tools support all PSoC™ 4s. The associated BSP
and library configurators also work on all three host operating systems.

Application note 6 001-79953 Rev. *Z
2024-02-26



o~ _.
Getting started with PSoC™ 4 MCU < In fI neon

2 Development ecosystem

ModusToolbox™

Command
Line
Interface

Figure 2 ModusToolbox™ environment

Certain features of the PSoC™ 4, such as UDBs (Universal Digital Blocks) and USB are not supported in
ModusToolbox™ version 2.x and earlier. Newer versions of ModusToolbox™ support the USB host feature and
improve the user experience with true multi-core debug support.

It is recommended to use ModusToolbox™ if you want to build an loT application using loT devices, or if you are
using a PSoC™ 4 not supported in PSoC™ Creator.

PSoC™ Creator is the long-standing proprietary tool that runs on Windows only. This mature IDE includes a
graphical editor that supports schematic based design entry with the help of Components. PSoC™ Creator
supports all PSoC™ 3, PSoC™ 4, and PSoC™ 5LP devices, and a subset of PSoC™ 4 devices.

Choose PSoC™ Creator if you are using a graphical editor for design entry and code generation, and if the PSoC™
MCU that you are planning to use is supported by the IDE.

2.2.3 ModusToolbox™ software

ModusToolbox™ software is a set of tools and software that enables an immersive development experience for
creating converged MCU and wireless systems, and enables you to integrate our devices into your existing
development methodology. These include configuration tools, low-level drivers, libraries, and operating system
support, most of which are compatible with Linux-, macOS-, and Windows-hosted environments.

Figure 3 shows a high-level view of what is available as part of ModusToolbox™ software. For a more in-depth
overview of the ModusToolbox™ software, see ModusToolbox™ tools package user guide.
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Applications

Code Examples Reference Designs

Power Delivery

Middleware
Human-Machine . » :
Vit Graphics Connectivity Security
Voice / Audio Machine Learning Wi-Fi Bluetooth®
BSPs

Tools

Project
Creator

Library
Manager

Eclipse and
partner IDEs

Configurators

and Tuners

Microcontrollers . Wi-Fi Bluetooth® Git and Make
(e build system
Figure 3 ModusToolbox™ software

The ModusToolbox™ tools package installer includes the design configurators and tools, and the build system

infrastructure.

The build system infrastructure includes the new project creation wizard that can be run independent of the
Eclipse IDE, the make infrastructure, and other tools. This means you choose your compiler, IDE, RTOS, and
ecosystem without compromising usability or access to our industry-leading CAPSENSE™ (Human-Machine

Interface), AIROC™ Wi-Fi and Bluetooth’, security, and various other features.

One part of the ModusToolbox™ ecosystem is run-time software that helps you rapidly develop Wi-Fi and
Bluetooth” applications using connectivity combo devices. See the ModusToolbox™ run-time software reference

guide for details.

Design configurators are the tools that help you create the configurable code for your BSP/Middleware. Jump to

Configurators to know more about it.

All the application-level development flows depend on the provided low-level resources. These include:

« Board support packages (BSP) - A BSP is the layer of firmware containing board-specific drivers and other
functions. The BSP is a set of libraries that provides APIs to initialize the board and access to board level
peripherals. It includes low-level resources such as peripheral driver library (PDL) for PSoC™ 4 and has
macros for board peripherals. Custom BSPs can be created to enable support for end-application boards.

See BSP Assistant to create your BSP.

+  PSoC™4 peripheral driver library (PDL) - The PDL integrates device header files, start-up code, and
peripheral drivers into a single package. The PDL supports the PSoC™ 4 family. The drivers abstract the
hardware functions into a set of easy-to-use APIs. These are fully documented in the PDL API Reference.

The PDL reduces the need to understand register usage and bit structures, thus easing software
development for the extensive set of peripherals in the PSoC™ 4 series. You configure the driver for your

application, and then use API calls to initialize and use the peripheral.

«  Middleware (MW) - Extensive middleware libraries that provide specific capabilities to an application.
The available middleware spans across connectivity (OTA, Bluetooth’, AWS loT, Bluetooth® LE, Secure
Sockets) to PSoC™ 4-specific functionality (CAPSENSE™, USB, device firmware upgrade (DFU), emWin). All

the middleware is delivered as libraries and via GitHub repositories.
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2 Development ecosystem

2.2.4 ModusToolbox™ applications

With the release of ModusToolbox™ v3.x, multi-core support is introduced, which has altered the folder
structure slightly from the previous version of ModusToolbox™, but PSoC™ 4 has single core only.

Combined

Single-core application

Figure 4 Application type

The following shows the new folder structure for an example single-core application:
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<root>
ApplicationName
—>Makefile (MTB TYPE=COMBINED)
—->deps
libl.mtbh (local)
1lib2.mtb (shared)
->1ibs
libl (Infineon Git repo)
->bsps
TARGET BSP1l (not an Infineon Git repo; completely app-owned)
—>templates
TARGET BSP1
design.modus
design.capsense
—>main.c
—->helper.h
—>helper.c
mtb shared

1lib2/... (Infineon Git repo)
Figure 5 Folder structure for single-core applications
2.2.5 PSoC™ 4 software resources

The software for PSoC™ 4s includes configurators, drivers, libraries, middleware, as well as various utilities,
makefiles, and scripts. It also includes relevant drivers, middleware, and examples for use with loT devices and
connectivity solutions. You may use any or all tools in any environment you prefer.

2.2.5.1 Configurators

ModusToolbox™ software provides graphical applications called configurators that make it easier to configure a
hardware block. For example, instead of having to search through all the documentation to configure a serial
communication block as a UART with a desired configuration, open the appropriate configurator and set the
baud rate, parity, and stop bits. Upon saving the hardware configuration, the tool generates the "C" code to
initialize the hardware with the desired configuration.

There are two types of configurators: BSP configurators that configure items that are specific to the MCU
hardware and library configurators that configure options for middleware libraries.

Configurators are independent of each other, but they can be used together to provide flexible configuration
options. They can be used stand alone, in conjunction with other tools, or within a complete IDE. Configurators
are used for:

+  Setting options and generating code to configure drivers

+  Setting up connections such as pins and clocks for a peripheral
+  Setting options and generating code to configure middleware
For PSoC™ 4 applications, the available Configurators include:

+  Device Configurator: Sets up the system (platform) functions and the basic peripherals (for example, UART,
Timer, PWM).
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+  CAPSENSE™ Configurator and Tuner: Configures CAPSENSE™ and generates the required code.
«  Smart I/O Configurator: Configures the Smart 1/0.

Each of the above configurators create their own files (For example, design.cycapsense for CAPSENSE™). BSP
configurator files (For example, design.modus or design.cycapsense) are provided as part of the BSP with default
configurations while library configurators (e.g. design.cybt) are provided by the application. When an
application is created based on Infineon BSP, the application makes use of BSP configurator files from the
Infineon BSP repo. You can customize/create all the configurator files as per your application requirement using
ModusToolbox™ software. See BSP Assistant to create your custom BSP. See ModusToolbox™ help for more
details.

2.2.5.2 Library management for PSoC™ 4

The application can have shared/local libraries for the projects. If needed, different projects can use different
versions of the same library. The shared libraries are downloaded under the mtb_shared directory. The
application should use the deps folder to add library dependencies. The deps folder contains files with the .mtb
file extension, which is used by ModusToolbox™ to download its git repository. These libraries are direct
dependencies of the ModusToolbox™ project.

The Library Manager helps to add/remove/update the libraries of your projects. It also identifies whether
particular library has a direct dependency on any other library using the manifest repository available on
GitHub, and fetches all its dependencies. These dependency libraries are indirect dependencies of the
ModusToolbox™ project. These dependencies can be seen under the 1ibs folder. For more information, see the
Library Manager user guide located at <install _dir> /ModusToolbox/tools_<version>/library-manager/docs/
library-manager.pdf.

2.2.5.3 Software development for PSoC™ 4

The ModusToolbox™ ecosystem provides significant source code and tools to enable software development for
PSoC™ 4s. You use tools to:

«  Specify how you want to configure the hardware.

«  Generate code for that purpose, which you use in your firmware.

« Include various middleware libraries for additional functionality, like Bluetooth® LE connectivity or
FreeRTOS.

This source code makes it easier to develop the firmware for supported devices. It helps you quickly customize
and build firmware without the need to understand the register set.

In the ModusToolbox™ environment, you use configurators to configure either the device, or a middleware
library, like the Bluetooth® LE stack or CAPSENSE™. The BSP configurator files are used to configure device
peripherals, pins, and memory using peripheral driver library code. The middleware is delivered as separate
libraries for each feature/function such that it can be used across multiple platforms. For example,
abstractionrtos, lwip, usb, etc.

Firmware developers who wish to work at the register level should refer to the driver source code from the PDL.
The PDL includes all the device-specific header files and startup code you need for your project. It also serves as
a reference for each driver. Because the PDL is provided as source code, you can see how it accesses the
hardware at the register level.

Some devices do not support particular peripherals. The PDL is a superset of all the drivers for any supported
device. This superset design means:

+ AllAPI elements needed to initialize, configure, and use a peripheral are available.
« ThePDL is useful across various PSoC™ 4s, regardless of available peripherals.
+ ThePDL includes error checking to ensure that the targeted peripheral is present on the selected device.
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This enables the code to maintain compatibility across members of the PSoC™ 4 family, as long as the
peripherals are available. A device header file specifies the peripherals that are available for a device. If you
write code that attempts to use an unsupported peripheral, you will get an error at compile time. Before writing
code to use a peripheral, consult the datasheet for the particular device to confirm support for that peripheral.

As the following figure shows, with the ModusToolbox™ software, you can:

1. Choose a BSP (Project Creator).

2. Create a new application based on a list of starter applications, filtered by the BSPs that each
application supports (Project Creator).

3. Add BSP or middleware libraries (Library Manager).

4, Develop your application firmware using PDL for PSoC™ 4 (IDE of choice or command line).

[ Choose Board Support Package (BSP) - Project Creator - o X [ select Application - Project Creator . o X
Settings  Help Settings  Help
Source Template
Path: .
Create from MPN... Browse for B5P... [=] [ | cvackT-oa15-max R Cmtw Browse.
, Terget IDE: Ecipse IDE for ModusToolbox”
Kit Name MCU/SOC/SIP Connectivity The PSoC™ 41005 Max Pioneer Kit enables you to evaluate
AROC™ Bluetooth® ESPs and develop with Cypress's ffth-generation, low-power y g o=
i o Browse for Application..| ¥ = 112 =] [ | This empty application provides a
- ‘CAPSENSE™ solution using the PSoC™ 41005 Max device
AIROCT Connectivy B5Ps “ < template for creating applications using
e - F— N Aolcton e, ew 5 e it
v PSoC™ 485Ps v Getting Started
cacKiT-0407 CYBC4046LQI-T452 <none> World's Most Reliable, Lowest Power CAPSENSE™ [ Empty PSoC4 App Fisio Werid APP_CYBCKIT-0415-MAX || For more detais,se the README on
CYBCKIT-041-41XX  CYBC4146AZI-5433 <none> Solution O Hello World g GitHub
CYBCKIT-041S-MAX  CYBCAT4SAZI-S598 <none> On-board Programmer and Debugger ] Power Modes
CYBCKIT-05S Cracasisazisies +Ready-to-Use CAPSENSET™ Buttors © perpherss
CYBCKIT-145-40KX  CYBCAO4SAZI-S413 v - O cano
cvaciT-149 CYBC414TAZISATS <none> oyt ] ClassB Safety Test Analog Peripherals
CYBCPROTO-040T  CYBCA046LQIT452 <none> « Themistor (] Class-B Safety Test Communication Protocol
PSOC4-GENERIC  CYBC4548AZ1-5485 <none> (] Class-B Safety Test Core Peripherals
PSoC™ 6 8Ps Kit Contents: ] Closo B Safety Test 12
TRAVEO™ BSPs « CYBCKIT-0415-Max PSAC™ 41005 Max Pioncer [ Class-B Safety Test 5P1 Loopback
Wireless Charging BPs Board ] Class-B Safety Test UART Loopback
XMC™ BSPs  CYBCKIT-0415-Max Capacitive Sensing Expansion [ Clock Bufter with Smart 10
Board [ Cryptography AES demenstration Froneear
£USE Type-A o Micro-3 cble ] Cryptography SHA Demonstation Anplications
+Sicumper vies [ Cryptography TRNG Demonsration
« Quick Stort Gaide (0] irection Detecton Using Quadrature Decoder
Oer
[ Frequenc usin
Choose Board Support n
Package [ GPio pins
] 12C Master E212C Slave v
Summary. A [Template Application’s): Empty PSaC4 App ~
Application(s) Root Path: C:/mtw
B5P: CYBCKIT-0415-MAX
Press “Create” to create the selected application(s).
Press "Next" o select application. v v
Next [ <Back Creat a
e Library Manager — O X [ mtw-Hello Worid/mainc - Eclipse IDE for ModusToolbox™ 32 - o x
Setings  Help He Eoit Sowce Refacior Navgate Searth Project Bun Window Help
Rl 8K G b 0 -G ® -0 e = Q8@
Appication Diectory: [Cymw el Browse,, | | GPje X fDebug ¥iRegl. FPerp.. = 5 BREADMEMS  [@mainc X =8 3 ouine x =8
=% . s BARN e %
S puopertes  READMEMd & Hello Worig  opdn
- “int main(void) u qusph
Name Updte Aviatle Remove | [property Value { . o Lo peLa s
v Name APP_CYBCKIT-0415-MAK oL text ¢ CYasP UART contests # CLASSERT_FAILED
(O AP CYBCKIT-0415-MAX (ACTIVE) - st schant context. £ RSP UART_contexts o mainivoid)
 Hello_WorldLraries Ve 31033410
anss
cwreib App Ovned
coremake o " [ failed. s
Location el Morldbsps/TARGET_ABP CYBCKT-0415-MAX
mib-polca2 § AL £ (result 1= CY_RSLT_SUCCESS)
recipe-make a2 Soue ;
CY_ASSERT(CY_ASSERT_FAILED);
o flelocaton  Makefle
# READMEMA
it shared = Config nable the UART peripheral *
Cy_SCB_UA YBSP_UART H, &CYBSP_UART_config, GCYBSP_UART context);
Cy_SCB_UART_Enable(CYBSP_UART_H4);
‘Add BSP/Middleware Enable
Librerics Douick. +Vora. Epre. *obreak. = O —eneble.s
Develop Firmware using
send a terninal PDL
Eclipse IDE for B Cy_SC8_ 4, "Hello world\r\n');
ModusToolbox™ i)
sadssp | | addLibrary o , )
oggle the user LED state
2 O Console (2 Problems = Progress 0 Memory 4 Terminal X gleo N $=n0
make S HeloViora Modusshell X
project mib-exa ShVISCIPFIYQRIE
dencies for project mtt-example-psoct-empty-2pp s
Summary
 World
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< >

Figure 6 ModusToolbox™ resources and middleware

2.2.6 ModusToolbox™ help

The ModusToolbox™ ecosystem provides documentation and training. One way to access it is launching the
Eclipse IDE for ModusToolbox™ software and navigating to the following Help menu items:

Choose Help > ModusToolbox™ General Documentation:

+  ModusToolbox™ Documentation Index: Provides brief descriptions and links to various types of
documentation included as part the ModusToolbox™ software.

+ ModusToolbox™ Installation Guide: Provides instructions for installing the ModusToolbox™ software.
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+  ModusToolbox™ User Guide: This guide primarily covers the ModusToolbox™ aspects of building,
programming and debugging applications. It also covers various aspects of the tools installed along with
the IDE.

+  ModusToolbox™ Training Material: Links to the training material available at https://github.com/Infineon/
training-modustoolbox.

+ Release Notes

For documentation on Eclipse IDE for ModusToolbox™, choose Help > Eclipse IDE for ModusToolbox™
Documentation:

+  User Guide: Provides descriptions about creating applications as well as building, programming, and
debugging them using Eclipse IDE

« Eclipse IDE Survival Guide

2.3 Support for other IDEs
You can develop firmware for PSoC™ 4s using your preferred IDE such as Eclipse IDE, IAR Embedded Workbench,
Keil pVision 5 or Visual Studio Code.

ModusToolbox™ Configurators are stand-alone tools that can be used to set up and configure PSoC™ 4 resources
and other middleware components without using the Eclipse IDE. The Device Configurator and middleware
configurators use the design.x files within the application workspace. You can then point to the generated
source code and continue developing firmware in your IDE.

If there is a change in the device configuration, edit the design.x files using the configurators and regenerate
the code. It is recommended that you generate resource configurations using the configuration tools provided
with ModusToolbox™ software.

See ModusToolbox™ tools package user guide for details.

2.4 PSoC™ Creator

PSoC™ Creator is an IDE that enables concurrent hardware and firmware editing, compiling, and debugging of
PSoC™ systems. Do the following to browse through PSoC™ Creator, as shown in Figure 7:

1. Drag and drop Components to build your hardware system design

2. Co-design your application firmware with the PSoC™ hardware

3. Configure Components with config tools

4, Explore the library of more than 100 Components

5. Review Component datasheets
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Figure 7 Features of PSoC™ Creator features
24.1 PSoC™ Creator hel
4. o reator netp

Download the PSoC™ Creator’s latest version from the PSoC™ Creator home page, launch the PSoC™ Creator,
and navigate to the following:

+  Quick Start Guide: Choose Help > Documentation > Quick Start Guide. This guide gives you the basics for
developing PSoC™ Creator projects.

«  Simple Component example projects: Choose File > Open > Example projects. These example projects
demonstrate how to configure and use PSoC™ Creator Components.

+  System Reference Guide: Choose Help > System Reference > System Reference Guide. This guide lists and
describes the system functions provided by PSoC™ Creator.

+ Component datasheets: Right-click a Component and select Open Datasheet. Visit the PSoC™ 4
Component datasheets page for a list of all PSoC™ 4 Component datasheets.

+  PSoC™ Creator training videos: These videos provide step-by-step instructions on how to get started with
PSoC™ Creator.

+  Document Manager: PSoC™ Creator provides a document manager to help you to find and review
document resources easily. To open the document manager, choose the menu item Help > Document
Manager.

2.5 Technical support

If you have any questions, our technical support team is happy to assist you. You can create a support request
on the Technical support page. The support team monitors and responds to your questions, issues, and bug
reports posted on the GitHub repositories.
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3 PSoC™ 4 feature set

PSoC™ 4 has an extensive set of features, which include a CPU and memory subsystem, a digital subsystem, an
analog subsystem, and system resources, as shown in Figure 8. The following sections describe each feature.
For more information, see the PSoC™ 4 family device datasheets, technical reference manuals (TRMs), and
application notes listed in PSoC™ resources.

CPU Subsystem
PSoC™ 4100S
Max SWD/TC, MTB SPCIF
Cortex® .
MO+ FLASH SRAM ROM DataWire /
32-bit 384 KB 32 KB 8 KB DMA
48 MHz
AHB-Lite NVICF/I.\:él\IrLLJJ)I(_ VPU Read Accelerator SRAM Controller ROM Controller Initiator/MMIO
System Resources ii ii ﬁ ii ﬁ
Lite | System Interconnect (Single Layer AHB) |
; N
Power
Sleep Control Pe”pherals ii
FOR W|'C FEF N Peripheral Interconnect (MMIO)
1L 30 1L JLIL I 100301210 IO
Clock
Clock Control Programmable l_
WDT < o o g
0| MO - Gligles ol [S] 8] [x 5]
= =l 2|2 |&]]% Al o
Reset R SAR ADC =l lgllz]|2l]|e]|ollallE e &
2|l & (12-bit) S al|Q € 2119 |0 = =
ol & 1S SIS I=][=3] |2 < e
(] (=i} x =< 8 [ (%) < = 5
Test &|lo @ N %) j N g
TestMode Entry o < <
Digital DFT G 22 o
Analog DFT T |3 X AA A A A X X £
©
SARMUX 1xCTBm
A 2x Opamp
\_ A A /
A4 \ A A4 y A \ 4 y \ 4
[ High Speed 1/0 Matrix and 3x Smart I/O |
Power Modes ¢
[ Active/Sleep | [ Up to 84x GPIOs ]
[ Deep Sleep
1/0 Subsystem
Figure 8 PSoC™ 4000 architecture (PSoC™ 4100S Max)

The PSoC™ 4 portfolio consists of several families of Arm” CM0 and CMO+ microcontrollers. Most devices in the
portfolio have CAPSENSE™ technology for capacitive-sensing applications. Other key features of the PSoC™ 4
portfolio include a customizable analog front end through programmable analog blocks and wired and wireless
connectivity options such as USB, Controller Area Network (CAN), and Bluetooth® LE. These unique features
make PSoC™ 4 the industry’s most flexible and scalable low-power mixed-signal architecture. The PSoC™ 4
devices are classified as different families, as shown in Table 2, based on different features.

Table 2 PSoC™ 4 families
Classification Family Features Details
Entry level PSoC™ 4000 family CAPSENSE™ Table 3

(table continues...)
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Table 2 (continued) PSoC™ 4 families
Classification Family Features Details
Intelligent analog PSoC™ 4100 family CAPSENSE™ + Table 4
Programmable Analog
Programmable digital PSoC™ 4200 family CAPSENSE™ + Table 5
Programmable Analog +
Programmable Digital
Blocks
Application specific PSoC™ 4500 family CAPSENSE™ + Motor Table 6
Control
PSoC™ 4700 family CAPSENSE™ + Inductive
Sensing
Analog coprocessor? PSoC™4A00 family CAPSENSE™ + AN211293
Programmable Analog
Blocks
Note: In Table 3 and Table 4, the columns highlighted in green indicate that the device family is supported in
ModusToolbox™.
Table 3 PSoC™ 4000 family features
Features PSoC™ 4000 PSoC™ 4000S PSoC™ 4000T
CPU 16-MHz Cortex™-M0 | 48-MHz Cortex -MO0+ | 48-MHz Cortex -M0+
Flash memory 16 KB 32 KB 64 KB
SRAM 2 KB 4 KB 8 KB
GPIOs 20 36 21
CAPSENSE™ Sense pins 16 35 19
Ultra-Low No No Yes
Power Wake
on Touch
(WoT)
CAPSENSE™ | Fourth-generation |Fifth-generation Fifth-generation
IP Generation Low Power
Single-slope ADC (10-bit 46-ksps) None 1 None
Comparators 1 CSD comparator | Two low-power None
with a fixed comparators with
threshold (1.2 V) wakeup feature
IDACs? One 7-bitand one | Two 7-bits None
8-bit
Smart I/O ports None 2 None
(table continues...)
See AN211293 for getting started with PSoC™ 4 analog coprocessor family devices.
3 IDACs are available only when CAPSENSE™ is not in use. See the respective PSoC™ 4 architecture TRM for more details.
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Table 3 (continued) PSoC™ 4000 family features
Features PSoC™ 4000 PSoC™ 4000S PSoC™ 4000T
Power supply range 1.71Vto 5.5V 1.71Vto 5.5V 1.71Vto 5.5V

Low-power modes Deep Sleep at Deep Sleep at Deep Sleep at

2.5pA 2.5pA 2.5pA
Segment LCD drive None 4 COM segment LCD | None
drive
Serial communication Onel2C Two SCBs with 1 SCB with
programmable 12C, | programmable 12C,
SPI, or UART SPI, or UART. 1 SCB
having I2C only
Timer Counter Pulse-Width Modulator 1 5 2
(TCPWM)
Clocks Internal main oscillator (IMO) |24 MHz/32 MHz 24 MHzto 48 MHz |24 MHz to 48 MHz
Internal low-speed oscillator |32-kHzinternal ILO |40 kHz 40 kHz
(ILO)
Watch crystal oscillator None 32-kHZ None
(WCO)
Power supply monitoring Power-on reset POR, BOD POR, BOD
(POR)Brown-out
detection (BOD)
Supported kit CY8CKIT-040 - CY8CKIT-040T
pioneer kit PSoC™4000T
CAPSENSE™
Evaluation Kit and
CYS8CPROTO-040T
PSoC™4000T
CAPSENSE™
Prototyping Kit
Supported IDE PSoC™ Creator PSoC™ Creator, ModusToolbox™

ModusToolbox™

Table 4 PSoC™ 4100 family features
Features PSoC™ PSoC™ PSoC™ PSoC™ PSoC™ PSoC™ PSoC™ PSoC™
4100 4100S 4100S 4100S 4100PS 4100M 4100 BLY |4100S
Plus Plus 256K Max
CPU 24-MHz 48-MHz 48-MHz 48-MHz 48-MHz 24-MHz 24-MHz 48-MHz
Cortex -MO | Cortex' - | Cortex- |Cortex- |Cortex- |Cortex-MO | Cortex -MO0 | Cortex -
MO+ MO+ MO+ MO+ MO+
DMA N/A N/A 8 channels | 8 channels | 8 channels | 8 channels |8 channels | 16
channels

(table continues...)

4 See AN91267 for getting started with PSoC™ 4 Bluetooth® LE Family devices.
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Table 4 (continued) PSoC™ 4100 family features

Features PSoC™ PSoC™ PSoC™ PSoC™ PSoC™ PSoC™ PSoC™ PSoC™
4100 41008 41008 41008 4100PS 4100M 4100 BLY |4100S

Plus Plus 256K Max

Flash 32 KB 64 KB 128 KB 256 KB 32 KB 128 KB 256 KB 384 KB

memory

SRAM 4 KB 8 KB 16 KB 32 KB 4 KB 16 KB 32 kB 32 KB

GPIOs 36 36 54 54 38 55 36 84

CAPSENSE™ | 1 channel, |1 channel, |1 channel, |1channel, |1 channel, |2 1channel, |2
3555ensors | 35 sensors | 53 sensors | 53 sensors |33 sensors | channels, | 35 sensors | channels,

54 sensors 80 sensors
(32 control
mux)

12-bit SAR | 806-KSPS |1-MSPS 1-MSPS 1-MSPS 1-MSPS 806-KSPS |806-KSPS |1-MSPS

ADC with

sequencer

Opamps 2 2 2 2 4/PGA 4 2 2

(programm

able)

Programma |None None None None Four None None None

ble Voltage channels

Reference

(PVref)

Voltage DAC |None None None None Two 13-bit | None None None

(VDAC) VDAC

Comparator |2 2 2 2 2 2 2 2

s (low

power with

wakeup

feature)

IDACs® One 7-bit | Two 7-bits | Two 7-bits | Two 7-bits | Two 7-bits | Two 7-bits | One 7-bit |None
and one 8- and two 8- | and one 8-
bit bits bit

Smart 1/O None 2 3 2 1 None None 3

ports

Power 1.71Vto 1.71Vto 1.71Vto 1.71Vto 1.71Vto 1.71Vto 1.71Vto 1.71Vto

supply 55V 55V 55V 55V 55V 55V 55V 55V

range

Low- |Deep|1.3 pA 2.5pA 2.5 pA 2.5 pA 2.5 pA 1.35pA 2.5 pA 2.5 pA

powe |slee

r P

(table continues...)

See AN91267 for getting started with PSoC™ 4 Bluetooth® LE Family devices.

5 IDACs are available only when CAPSENSE™ is not in use. See the respective PSoC™ 4 architecture TRM more details.
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Table 4 (continued) PSoC™ 4100 family features
Features PSoC™ PSoC™ PSoC™ PSoC™ PSoC™ PSoC™ PSoC™ PSoC™
4100 4100S 41008 4100S 4100PS 4100M 4100 BLY |4100S
Plus Plus 256K Max
mod |Hibe | 150 nA NA NA NA NA 150 nA NA NA
es rnat
e
Stop |20 nA NA NA NA NA 35nA NA NA
Segment 4 COM 4 COM 4 COM 4 COM 4 COM 4 COM 4 COM 4 COM
LCD drive
SCBs with 2 3 5 5 3 4 2 5
programma
ble 12C, SPI,
or UART
TCPWM 4 5 8 8 8 8 4 8
CAN None None 1 None None None None 1
BLE None None None None None None 4.1/4.2 None
Clock [IMO |3 MHzto 24 MHzto |24 MHzto |24MHzto |24 MHzto |3 MHzto 24 MHzto |24 MHzto
s 24MHz  |48MHz  |48MHz  |48MHz  |[48MHz |48 MHz |48MHz |48 MHz
ILO |32 kHz 40 kHz 40 kHz 40 kHz 40 kHz 32 kHz 40 kHz 40 kHz
WCO | Nil 32 kHz 32 kHz 32 kHz 32 kHz 32 kHz 32 kHz 32 kHz
Power POR, BOD, | POR,BOD |POR,BOD |POR,BOD |POR,BOD |POR,BOD, |POR,BOD, | POR,BOD
supply Low- LVD LVD
monitoring |voltage
detection
(LVD)
Supported |- - CY8CKIT-1 |- CY8CKIT-1 |CY8CKIT-0 |CY8CKIT-0 | CY8CKIT-0
kit 49 47 44 pioneer |42 BLE 41S-MAX
prototypin prototypin | kit pioneer kit | pioneer kit
g kit g kit
Supported |PSoC™ PSoC™ PSoC™ PSoC™ PSoC™ PSoC™ PSoC™ ModusToo
IDE Creator Creator, Creator, Creator, Creator Creator Creator lbox™
ModusToo | ModusToo | ModusToo
[box™ lbox™ lbox™
Table 5 PSoC™ 4200 family features
Features PSoC™ 4200 PSoC™4200DS |PSoC™4200M |PSoC™4200L PSoC™ 4200
BL®
CMO CPU 48 MHz Cortex - |48 MHz Cortex'- |48 MHz Cortex - |48 MHz Cortex - |48 MHz Cortex -

MO

MO

MO

MO

MO

(table continues...)

4 See AN91267 for getting started with PSoC™ 4 Bluetooth® LE Family devices.
6 See AN91267 for getting started with PSoC™ 4 Bluetooth® LE family devices.
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Table 5 (continued) PSoC™ 4200 family features
Features PSoC™ 4200 PSoC™4200DS | PSoC™4200M |PSoC™4200L PSoC™ 4200
BL®
DMA None 8 channels 8 channels 32 channels None
Flash memory 32 KB 64 KB 128 KB 256 KB 256 KB
SRAM 4 KB 8 KB 16 KB 32 KB 32KB
GPIOs 36 21 55 96 36
CAPSENSE™ 1 channel, 35 None 2 channels,54 |2channels,94 |1 channel, 35
sensors sensors sensors sensors
ADC (12-bit, 1-MSPS |1 None 1 1 1
SAR ADC with
sequencer)
Opamps 2 None 2 4 2
(programmable)
Comparators (low 2 2 2 2 2
power with wakeup
feature)
IDACs”) One 7-bitsand |None Two 7-bits and | Two 7-bitsand | One 7-bit and
one 8-bit two 8-bits two 8-bits one 8-bit

Programmable logic |4 4 4 8 4
blocks (UDBs)
Smart /O ports None 1 None None None
Power supply range |1.71Vto5.5V 1.71Vto 5.5V 1.71Vto 5.5V 1.71Vto 5.5V 1.71Vto 5.5V
Low- Deep 1.3 pA 2 YA 1.3 pA 1.3 pA 1.5pA
power Sleep
modes [\ jibernat | 150 nA NA 150 nA 150 nA 150 nA

e

Stop 20 nA NA 20 nA 20 nA 20 nA
Segment LCD drive |4 COM None 4 COM 8 COM 4 COM
SCBs with 2 3 4 4 2
programmable 12C,
SPI, or UART
TCPWM 4 4 8 8 4
CAN None None 2 2 None
BLE None None None None 4.1/4.2
USB Full Speed None None None Yes None

Device Controller
(USB)

(table continues...)

See AN91267 for getting started with PSoC™ 4 Bluetooth® LE family devices.

7
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Table 5 (continued) PSoC™ 4200 family features
Features PSoC™ 4200 PSoC™4200DS |PSoC™4200M |PSoC™4200L PSoC™ 4200
BL®
Clocks IMO 3MHzto 48 MHz | 3 MHz t0 48 MHz | 3 MHz to 48 MHz | 3 MHz to 48 MHz | 3 MHZz t0 48 MHz
ILO 32 kHz 40 kHz 32 kHz 32 kHz 32 kHz
WCO None None 32 kHz 32 kHz 32 kHz
External |None None 4 MHz to 33 MHz | None None
crystal
oscillator
(ECO)
Power supply POR, BOD, LVD |POR, BOD POR, BOD, LVD |POR,BOD,LVD |POR,BOD,LVD
monitoring
Supported kit CY8CKIT-042 CY8CKIT-146 CY8CKIT-044 CY8CKIT-046 CY8CKIT-042
pioneer kit prototyping kit | pioneer kit pioneer kit Bluetooth® LE
pioneer kit
Supported IDE PSoC™ Creator |PSoC™Creator |PSoC™Creator |PSoC™Creator |PSoC™Creator
Table 6 PSoC™ 4500 and PSoC™ 4700 family features
Features PSoC™ 4500S PSoC™ 4700S
CMO+ CPU 48 MHz Cortex -M0+ 48 MHz Cortex -M0+
DMA 8 channels None
Flash memory 256 KB 32 KB
SRAM 32KB 4 KB
GPIOs 53 36
CAPSENSE™ 1 channel, 52 sensors 1 channel, 35 sensors
MagSense None 1 channel
ADC Two 12-bits, 1-MSPS SAR | 10-bit, 16.8-ksps Single
ADCs with sequencer slope ADC
Opamps (programmable) 4 None
Comparators (low power with wakeup feature) 2 2
IDACs® Two 7-bits Two 7-bits
Smart I/O ports 2 2
Power supply range 1.71Vto 5.5V 1.71Vto5.5V
Low-power modes Deep Sleep 1.3 pA 2.5 A
Hibernate 150 nA NA
Stop 20 nA NA
Segment LCD drive 4 COM 8 COM
(table continues...)
See AN91267 for getting started with PSoC™ 4 Bluetooth® LE family devices.
8 IDACs are available only when CAPSENSE™ is not in use. See the respective PSoC™ 4 architecture TRM for more details.
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Table 6 (continued) PSoC™ 4500 and PSoC™ 4700 family features
Features PSoC™ 4500S PSoC™ 4700S
SCBs with programmable 12C, SPI, or UART 5 2
TCPWM 8 5
Motor Control Acceleration (MCA) 2 None
Clocks IMO 24 MHz to 48 MHz 24 MHz to 48 MHz
ILO 40 kHz 40 kHz
WCO 32 kHz 32 kHz
ECO 4 MHz to 33 MHz None
Power supply monitoring POR, BOD POR, BOD
Supported kit CY8CKIT-045S pioneer kit | CY8CKIT-148 evaluation
kit
Supported IDE PSoC™ Creator PSoC™ Creator
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4 PSoC™ is more than an MCU

Figure 9 shows that a typical MCU contains a CPU (such as 8051 or an Arm’ Cortex’) with a set of peripheral
functions such as ADCs, DACs, UARTS, SPIs, and general I/0, all linked to the CPU’s register interface. Within the
MCU, the CPU is the “heart” of the device - the CPU manages everything from setup to data movement to
timing. Without the CPU, the MCU cannot function.

Figure 10 shows that PSoC™ is quite different. With PSoC™, the CPU, analog, digital, and I/0 are equally
important resources in a programmable system. It is the system’s interconnect and programmability that is the
heart of PSoC™ - not the CPU. The peripheral analog and digital are interconnected with a highly configurable
matrix of signal and data bus meshing that allows you to create custom designs that meet your application
requirements. You can program PSoC™ to emulate an MCU, but you cannot program an MCU to emulate PSoC™.

walih A

| Port A | | Port B |

ADC
_‘ SPI X
DAC ARM

12C X
X Pu_|—{
| Potc | | PortD |
Figure 9 Typical MCU block diagram
l GenlO ‘ l Gen 0 ‘
‘ ‘ Digital System
N
M o Digital System SCBs Segment
E: (with Programmable Logic) UDBs PWMs U(LZRC'Ii SL'IDIII’) CAN ;‘E\Z use
X s
Arm® Cortex® MO/MO+
Analog System
X
c SARADC CTB Low P CAPSENSEh
- g Analog System and MUX (opamn:js) an\:/paci\;vte;r (IDACs, Comparators, Touch Sensing)
X
l GenlO ‘ l Gen 10 ‘
Figure 10 PSoC™ block diagram

A typical MCU requires CPU firmware to process state machines, use a timer for timing, and drive an output pin.
Therefore, the functional path is always through the CPU. However, with PSoC™, asynchronous parallel
processing is possible. You can configure a PSoC™ to have elements that operate independently from the CPU.
The projects included with this application note demonstrate this concept. The PSoC™ is configured to make an
LED blink without writing any code for the CPU as mentioned in section Part 1: Create the design.
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4.1 The concept of PSoC™ Creator Components

One other important thing about PSoC™ is the availability of PSoC™ Creator IDE. In PSoC™ Creator, different
PSoC™ resources are organized as graphical elements called Components, which can be dragged and dropped
onto a schematic to quickly build designs. Every peripheral in PSoC™ is available as a pre-validated PSoC™
Creator Component - PWM Component, ADC Component, DAC Component, CAPSENSE™ Component, UART
Component and so on. The availability of pre-validated Components in the PSoC™ Creator significantly reduces
the development time. It also allows you to quickly make changes in the design using graphical options.

For example, configuring a PWM to blink an LED in a typical microcontroller involves the following:

1. Locate the registers corresponding to the PWM block.

2, Calculate the values to be written to the PWM registers based on the required PWM period and duty
cycle.

3. Write many lines of code to configure the PWM registers, set the pin drive mode, and to connect the PWM
output to the pin. Many MCUs do not offer alternate pins to connect to the internal blocks.

To implement the same functionality in PSoC™ is a trivial exercise, as you will find out later in this application
note. Later, if you need to reconfigure the same PWM block to a Timer, you do not need anything more than a
few mouse clicks in PSoC™ Creator.

The PSoC™ also has programmable digital blocks known as Universal Digital Blocks (UDBs). PSoC™ Creator also
provides several Components made of UDBs such as UART, SPI, 12C, Timer, PWM, Counter, Digital Gates (AND,
OR, NOT, XOR, and so on), and many more. You can even create your own custom state machines and digital
logic using the UDBs in PSoC™ Creator. The method to create your own custom PSoC™ Creator Components is
provided in the PSoC™ Creator Component author guide.
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This section does the following:
+ Demonstrate how to build a simple PSoC™ 4-based design and program it on to the development kit

+  Makes it easy to learn PSoC™ 4 design techniques and how to use the ModusToolbox™ software and Eclipse
IDE.

Note: You can use any supported IDE, but this section uses the Eclipse IDE as an example.

5.1 Prerequisites

Before you get started, make sure that you have the appropriate development kit for your PSoC™ 4 product line
and have installed the required software. You also need internet access to the GitHub repositories during
project creation.

5.1.1 Hardware

Testing this design requires one of the kits listed in Table 7, which has an integrated programmer.
Table 7 List of PSoC™ 4 pioneer kits, prototyping kits, and supported devices

Kit name Kit type Supported device family Part number
CY8CKIT-145 Prototyping kit PSoC™ 4000S CY8C4045AZ1-S413
CY8CKIT-149 Prototyping kit PSoC™4100S Plus CY8C4147AZI-S475
CY8CKIT-041S-Max Pioneer kit PSoC™4100S Max CY8C4149AZ1-S598
CY8CKIT-040T Evaluation kit PSoC™4000T CY8C4046LQI-T452
CY8CPROTO-040T Prototyping kit PSoC™4000T CY8C4046LQI-T452

5.1.2 Software

ModusToolbox™ software 3.2 or above.

After installing the software, refer to the ModusToolbox™ tools package user guide to get an overview of the
software.

5.2 Using these instructions

These instructions are grouped into several sections. Each section is devoted to a phase of the application
development workflow. The major sections are:

1. Create a BSP for your board

Create a new application

View and modify the design configuration

Write firmware

Build the application

Program the device

7. Test your design

o umhwN

If you are familiar with developing projects using ModusToolbox™, you can use one of the supported starter
applications for your kit, such as Hello World or Blinky directly. This starter application is a complete project,
which can run on supported kits without any additional code or configuration. This design is developed for the
kits listed in Table 7. You can test this example by selecting the appropriate kit while creating the application.
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You can go through the instructions in the README.md file and observe how the steps are implemented in the
code example.

Even if you are creating a different application from scratch following the instructions in this application note,
you can use this code example as a reference.

5.3 About the design

This design uses the PSoC™ 4 MCU to blink an LED. On kits that support UART, the “Hello World” message is
printed to the serial port stream.

5.4 Create a BSP for your board

All ModusToolbox™ applications require a target BSP. Infineon provides BSPs for all of our kits (including the kits
mentioned in Table 7) and for each chip architecture to use as a starting point. When working with your own
hardware, you can modify an Infineon BSP to match the hardware. The BSP Assistant helps to simplify the
process. If you are developing for your own hardware, create a custom BSP by following the steps given in
ModusToolbox™ BSP Assistant user guide. Section Opening the Device Configurator describes how the
configuration of the custom BSP can be edited.

5.5 Create a new application

This section takes you on a step-by-step guided tour of the new application process. It uses the Empty PSoC4
App starter application and manually adds the functionality from the Hello World starter application. The
Eclipse IDE for ModusToolbox™ is used in the instructions, but you can use any IDE or the command line if you
prefer.

If you are familiar with developing projects with ModusToolbox™ software, you can use the Hello World starter
application directly. It is a complete design, with all the firmware written for the supported kits. You can walk
through the instructions and observe how the steps are implemented in the code example.

If you start from scratch and follow all the instructions in this application note, you can use the Hello World
code example as a reference while following the instructions.

Launch the Dashboard 3.2 application to get started. Please note that the Dashboard 3.2 application needs
access to the internet to successfully clone the starter application onto your machine.

The Dashboard 3.2 application helps you get started using the various tools with easy access to
documentation and training material, a simple path for creating applications and creating and editing BSPs.
1. Open the Dashboard 3.2 application.
To open the Dashboard 3.2 application, click [ModusToolbox installation path]/tools_3.2/dashboard/
dashboard.exe

2. On the Dashboard 3.2 window, in the right pane, in the Target IDE drop-down list, select Eclipse IDE for
ModusToolbox™, and click Launch Eclipse IDE for ModusToolbox™.
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[ Dashboard 3.2
File Help

Learn Create

Create a new application for ...

[Farget IDE: |Eclipse IDE for ModusToolbox™ -]

| ocmi I
: " o v,
_HH 12 ’ 3 S

@ Launch Eclipse IDE for ModusToolbox™

ModusToolbox™ ' This option opens the Eclipse IDE. To create an application,

select the "New Application” option in the Eclipse IDE Quick
New to ModusToolbox™ software? ModusToolbox™ Documentation el

Edlipse IDE for ModusToolbox™ User Guide

Create or edit a Board Support Package (BSP)

BSP
h BSP Assi:

This option will launch the ModusToolbox™ BSP Assistant tool.
BSP Assistant User Guide

Video Tutorials Community Support Sign up for News

Install

ModusToolbox Setup is not installed. Use the following link

to install it:

Figure 11 Dashboard 3.2 application

3. Select a new workspace.

At launch, Eclipse IDE for ModusToolbox™ presents a dialog to choose a directory for use as the

works

pace directory. The workspace directory is used to store workspace preferences and development

artifacts. You can choose an existing empty directory by clicking the Browse button, as shown in the
following figure. Alternatively, you can type in a directory name to be used as the workspace directory
along with the complete path, and the IDE will create the directory for you.

[ Eclipse IDE for ModusToolbox™ 3.2 Launcher O >

Select a directory as workspace

Eclipse IDE for ModusToolbox™ 3.2 uses the workspace directory to store its preferences and development artifacts.

Ch\mtw ~ | | Browse... |

[] Use this as the default and do not ask again

Figure 12 Select a directory as the workspace

4, Create a new ModusToolbox™ application.

a.
b.

Application note

Click New Application in the Start group of the Quick Panel.

Alternatively, you can choose File > New > ModusToolbox™ Application, as shown in the
following figure.

The Project Creator opens.
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[ mtw - Eclipse IDE for ModusToolbox™
File Edit Navigate Search Project Run Window Help
[ v i vOvRv®yvB

EQ @V &E %8 <0
Eclipse IDE for
ModusTqalhox™

& Search Online for Code Example

& Search Online for Libraries and £
& Training Material
& Refresh Quick Panel

~ Project

~ Launches

Q miw - Eclipse IDE for ModusToolbox™

New
Open File..

L} Open Projects from File System...
Recent Files

© Console 52 [21 Problems O Memory &2 Terminal

“OR

File Edit Navigate Search Project Run Window Help
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There is no active
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an outline.

Alt+ShiftsN > = Project..

= Other. Cul+N
)|! ModusToolbox™ Application ~ Cirl+7 |
3

Figure 13
Select a target PSoC™ 4 development kit

Create a new ModusToolbox™ application

ModusToolbox™ speeds up the development process by providing BSPs that set various workspace/
project options for the specified development kit in the new application dialog.

a.

In the Choose Board Support Package (BSP) dialog, choose the Kit Name that you have. The

steps that follow use CYS8CKIT-041S-MAX. See Figure 14 for help with this step

b. Click Next

Application note
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Settings  Help

Source Template

Choose Board Support Package (BSP) - Project Creator

Enter fi

Create from MPN...

Kit Name

AIROC™ Bluetooth® BSPs

AIROC™ Connectivity BSPs

PMG BSPs

PSoC™ 4 BSPs
CYBCKIT-040T
CYBCKIT-041-41XX

<

MCU/SOC/sIP

CY8C4046LQI1-T452 <nonex
CY8C4146A71-5433 <none>

Connectivity

]

Browse for BSP...

[CYBCKIT-0415-MAX

CY8C4149AZI-5598 <none>

CYBCKIT-0455
CYSCKIT-145-40XX
CY8CKIT-149
CYBCPROTO-040T
PSOC4-GENERIC

CY8C4548A71-5485 <none>
CY8C4045AZ1-5413 <none>
CY8C4147AZI-S475 <nonex
CY8C4046LQI1-T452 <nonex
CY8C4548A71-3485 <none>

PSoC™ 6 BSPs
TRAVEO™ BSPs
‘Wireless Charging BSPs
XMC™ BSPs

F

CYBCKIT-041S-MAX

The PSoC™ 41005 Max Pioneer Kit enables you to evaluate
and develop with Cypress's fifth-generation, low-power
CAPSENSE™ solution using the PSoC™ 4100S Max device.

Kit Features:

*World's Most Reliable, Lowest Power CAPSENSE™
Solution

* On-board Programmer and Debugger

® Ready-to-Use CAPSENSE™ Buttons

* Ready-to-Use CAPSENSE™ Touchpad

* Ready-to-Use CAPSENSE™ Slider

* Ready-to-Use CAPSENSE™ Proximity

* Thermistor

Kit Contents:

* CYBCKIT-0415-Max PSoC™ 41005 Max Pioneer
Board

* CYBCKIT-041S-Max Capacitive Sensing Expansion
Board

* USB Type-A to Micro-B cable

* Six jumper wires

* 40 pin FFC cable

* Quick Start Guide

Summary:

BSP: CY8CKIT-041S-MAX

Press "Next" to select application.

.

Close

Figure 14
c.
figure.

leave the default name if you prefer.

Choose target hardware
In the Select Application dialog, select Empty App starter application, as shown in the following

In the Name field, type in a name for the application, such as Hello_World. You can choose to

Click Create to create the application, as shown in the following figure, wait for the Project

Creator to automatically close once the project is successfully created.
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Select Application - Project Creator - m] X
Settings Help
Application(s) Root Path: |C:/mtw Browse...
Target IDE: Eclipse IDE for ModusToolbox™
Enter filter text.. ‘ Browse for Application... 5" ; = =] U+ | This empty application provides a
o template for creating applications using
Template Application New Application Name  New BSP Name o PSoC™ 4 devices.
~ Getting Started .
Z| Empty PSoC4 App |[Helic_world | APP_cYsCKIT-0415-MAX For more details, see the README on
GitHub.
[ Hello World

[ Power Modes
~ Peripherals
[] CANFD
[[] Class-B Safety Test Analog Peripherals
[] Class-B Safety Test Communication Protocol
[] Class-B Safety Test Core Peripherals
[] Class-B Safety Test 12C
[] Class-B Safety Test SPI Loopback
[] Class-B Safety Test UART Loopback
[ Clock Buffer with Smart 10
[] Cryptography AES demonstration
[] Cryptography SHA Demonstration
[] Cryptography TRNG Demonstration
[] Direction Detection Using Quadrature Decoder
[] Emulated EEPROM
] Frequency measurement using TCPWM
[] GPIO Interrupt
] GPIO Pins

[] 12C Master EzI2C Slave
M 197 Clowie 10 Mimet i

Template Application(s): Empty PSoC4 App ~
Application(s) Root Path: C:/mtw

Press "Create” to create the selected application(s). E
N

Figure 15 Choose starter application
You have successfully created a new ModusToolbox™ application for a PSoC™ 4.

The BSP uses CY8C4149AZI1-S598 as the default device that is mounted on the PSoC™ 4 CYS8CKIT-041S-Max
Pioneer Kit.

If you are using custom hardware based on PSoC™ 4, or a different PSoC™ 4 part number, please refer to the
Create a BSP for your board or the BSP Assistant user guide.

5.6 View and modify the design configuration

Figure 16 shows the ModusToolbox™ Project Explorer displaying the structure of the application project.
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5 Project Explorer 2 4% Debug i Registers % Peripherals

~ =% Hello_World
ki Includes
~ [= bsps
~ = TARGET_APP_CY8CKIT-0415-MAX
= config
(= deps
(= docs
(= TOOLCHAIN_ARM
= TOOLCHAIN_GCC_ARM
= TOOLCHAIN_IAR
[b cybsp_doc.h
[5 cybsp_types.h
[ cybsp.c
[h cybsp.h
[ startup_psoc4100smax.c
[ system_catl.c
[n] system_cat2.h
L& bsp.mk
EULA
LICENSE
props.json
README.md
RELEASE.md

E & Y OE 6

& build

(= deps

(= images

= libs

[ main.c

| LICENSE

L& Makefile

[*] README.md
v =% mth_shared

= cmsis

(= caore-lib

(= core-make

(= mtb-pdl-cat2

= recipe-make-cat2

iy

':\J

% o000

a

Figure 16

Project explorer view

For understanding the files and folders in detail, see Section 2.4.2 in ModusToolbox™ tools package user guide.
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5.6.1 Opening the Device Configurator

You can modify the device configurations which is loaded by the selected BSP. For example, default kit BSPs do
not have UART enabled. Below steps show how to enable UART peripheral for “Hello World” printing operation
and how to enable User LED for PSoC™ 4 kits.

1. As shown in Figure 17, click Device configurator in the Quick Panel under the BSP Configurators
section. This opens the Device Configurator dialog(Figure 18). You can also open the other configurators

and configure as required.

w Quick Pa... |09=Variables 9 Express.. “s Breakp.. =
. Ll
+ B5P Configurators (APP_CYBCKIT-0415-MAX)
T 1
& CAPSENSE™ Configurator
; ™
bl CAPSENSE™ Tuner
i Device Conf gurator
. . _ . . .
= Segment LCD Configurator (new configuration)
i .
b Smart I/O Configurator
L
. . . o
Figure 17 Opening the Device Configurator
Device Configurator - a X
Fle Edt Settnos View Hep
CY8C4149A71-5598 MSC 0 (CYBSP_MSCO) - Parameters 8 x
|_Peripherals __pins __Analog-Routin: System __Peripheral-Clocks __ DMA ‘E\‘r:’r filter text O TEHRE
Enter filter text... List of Resources “.' HHF 4 = ame Value Parameters Pane
Resource Name(s) Personality I~ pe”"be'a‘ Documentation
Analog (?) Configuration Help Open MSC Documentation
v Communication [v Inputs
Controller Area Network FD (CAN FD) 0 (2) Clock Signal & | @ 16 bit Divider 0 clk (CYBSP_MSC_CLK_DIV) [SHARED] v
[ Inter-IC Sound Bus (125) 0 audioss_0_i2s_0 I+ DMA connections
[ Serial Communication Block (SCB) 0 scb 0 (?) Write DMAC Channel Trigger Output & | @ DMAC Channel 0 tr_out [USED] 7
[ serial (Dmm”“‘“'fc“ Block (SCB) 1 scb_1 ) Chain Write DMAC Channel Trigger Input| & | @ DMAC Channel 1 tr_in [USED] -
[ Serial Communication Block (SCB) 2 scb 2 ) Read DMAC Channel Trigger Output & | @ DMAC Channel 3 tr_out [USED] v
[ Serial Communication Block (SCB) 3 scb 3 P
} (?) Chain Read DMAC Channel Trigger Input | & | @ DMAC Channel 2 tr_in [USED] =
[J Serial Communication Block (SCB) 4 sch_4
- =3 I External Capacitors
Timer, Counter, and PWM (TCPWM) 0 (@) cmod1 & | @ Pa10) analog (CYBSP_MSCO_CMOD) [USED) v
v System (?) Cmod2 & | @ P4[1] analog (CYBSP_MSCO_CMOD2) [USED] ~
v CapSense CYBSP_CapSense CapSense-1.0 CapSense Sensors
MSC 0 CYBSP_MSCO MSC-1.1
MSC 1 CYBSP_MSC1 MSC-1.1 e
[ LCD Direct Drive 0 Ied_0_drive_0 Pane |
[] Watchdog Counters (WDC) 0 Code Preview 8 x
[ Watchdog Timer (WDT) Enter search text \
’ ~
- n the folder:
Genera cedsource
ginclude "ecy_syselk.h!
$include " .h" N
Notice List N g X
00 Erors | 0 Warnings DDTasks o1lnfo
Fix Description Location
Ready

Figure 18
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From the Resource Categories Pane of the Device Configurator dialog, you can choose different
resources to configure, such as peripherals, pins, and clocks.

The Peripherals tab shows a list of available peripherals in the device. The configuration in the
Personality column defines the behavior of the resource. For example, a Serial Communication Block
(SCB) resource can have EZI2C, 12C, SPI, or UART as personalities. The Name(s) field is the user-defined
name of the resource, which is used in firmware development. You can specify one or more names for
each pin, as ModusToolbox™ provides the ability to assign different aliases to the pins, corresponding to
different run-time configurations. Note that the listed names must be separated by commas with no
space.

In the Parameters pane, you can enter the configuration parameters for each enabled resource and the
selected personality. The Code Preview pane shows the configuration code generated for the selected
configuration parameters. This code is populated in the cycfg_ files in the GeneratedSource folder. Any
errors, warnings, and information messages, caused by the configuration, are displayed in the Notice

List pane.
2. Enable UART peripheral and configure the corresponding clocks as explained in the following steps:
Note: For the CYSCKIT-040T kit skip these steps because UART is not supported on this kit.

a. Go to the Peripherals tab in Resources Categories pane and enable Serial Communication
Block (SCB) 1, set personality as UART-1.0 and the name as "CYBSP_UART". In Figure 19, SCB
instance 1 is selected based on Rx/Tx pin required for the kit. As shown in Figure 20, the drop-
down of Rx and Tx configuration parameters shows pins supported by SCB 1. See the device
datasheet for the pins available for each SCB instance.

Resource MName(s) Personality

Analog
v Communication
Controller Area Network FD (CAN FD) 0

|:| Inter-1C Sound Bus (125) 0 audioss 0 i2s_0
] Serial Communication Block (SCB) 0 scb_0
=] Serial Communication Block (SCB) 1|CYBSP_UART UART-1.0 )

(| Serial Communication Block (SCB) 2 sch_2
[] Serial Communication Block (SCB) 3 sch 3
[] Serial Communication Block (SCB) 4 sch_ 4

Figure 19 Enabling SCB as UART
b. Set the required configuration parameters such as Clock, Rx, and Tx in the Parameter pane.
Retain the default values for other parameters.
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C.

Application note

Serial Communication Block (SCB) 1 (CYBSP_UART) - Parameters F x
Enter filter text.. O B
Name Value ol
v Peripheral Documentation
() Configuration Help Open UART (SCB) Documentation
v General
(%) Com Mode Standard
) Enable LIN Mode O
) Baud Rate (bps) [115200
) Oversample 8
(2) Bit Order LSB First
Data Width 8 bits
(@) Parity None
(%) Stop Bits 1 bit
(@) Enable Digital Filter 0
v Support RS-485
(3) TX-Enable O
v Flow Control
(%) Enable Flow Control O
Active Low
Active Low
7
v Connections
(7) Clock & | @ 16 bit Divider 1 clk (CY_BSP_UART) [USED]
& | @ Po[4] digital_inout (CYBSP_DEBUG_UART_RX) [USED]
& | @ PO[5] digital_inout (CYBSP_DEBUG_UART_TX) [USED] ~
< >
Serial Communication Block (SCB) 1 (CYBSP_UART) - Parameters Code Preview

Figure 20

Setting UART configuration parameter

Go to the Peripheral-Clocks tab in Resource Categories pane to configure the clock for UART

peripheral.

Tip:

[ Device Configurator - o X
File Edit Setings View Help
CY8C4149A71-5598 16 bit Divider 1 (CYBSP_UART_DIV) - Parameters 8 x
Peripherals  Pins  Analog-Routing  System [ Peripheral-Clocks | DMA e O YERE
Entel TEHE 4 = Name Value
Resource Narme(s) Personality V' Peripheral Documentation
v 16 bit (?) Configuration Help  Open Peripherals Clock Dividers Documentation
16 bit Divider 0 CYBSP_MSC CLK DIV Peripheral Clock-1.0 v _General
| 16 bit Divider 1 | CYBSP_UART_DIV Peripheral Clock-1.0 2) Source Clock ) HFCLK (48 MHzZ £ 2%)
T 76 b Divider 2 - Divider Calculation | Manual v
[J 16 bit Divider 3 Brvicer s2
[ 16 bit Divider 4 chieved Frequency (%) 923.1 kHz 2%
[ 16 bit Divider 5 tart on Reset
[ 16 bit Divider 6 ?) Peripherals & | @ Serial Communication Block (SCB) 1 clock (CYBSP_UART) [USED]
[ 16 bit Divider 7
[ 16 bit Divider 8
[ 16 bit Divider 9
[ 16 bit Divider 10 pe
[ 16 bit Divider 11
[ 16 bit Divider 12
[ 16 bit Divider 13
[] 16 bit Divider 14 peri 0 Code Preview L) S
16.5 bit et conrch ot
245 bit — —
7 ~
* NOTE: This is a preview only. It combines elements of the
“ cycfg_clocks.c and cycfg_clocks.h files located in the folder:
mtw/Hello_World/bsps/TARGET_APP_CYSCKIT-041S-MAX/config/GeneratedSource
*/
#include "cy sysclk.h"
v
Notice List & x
Qoo 1 owamings | [E]oTesks @ oinfos
Fix Description Location
Ready
Figure 21 Configuring clock

Go to the Code Preview pane to preview the generated code.
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Code Preview F x

Enter search text..

/* NOTE: This is a preview only. It combines elements of the ~
* cycfg_peripherals.c and cycfg_peripherals.h files located in the folder

* C:/mtw/Hello_World/bsps/TARGET APP_CYBCEIT-0418-MAX/COMPCNENT_BSP_DESIGN_MODUS/GeneratedSour
>/

finclude "cy_sck_uart.h"

finclude "cy sysclk.h"

§if defined (CY_USING_HAL)
finclude "cyhal hwmgr.h"

fendif //defined (C¥_USING_HAL)

fdefine CYBSP_UART_HW SCBL
fdefine CYBSP_UART_IRQ scb 1 interrupt IRCn

const cy stc sch uart_config t CYBSP_UART config =
{
.uartMode = CY SCB UART STANDARD,
.enableMutliProcessorMode = false,
.smartCardRetryOnNack = false,
.irdaInvertRx = false,
.irdaEnablelLowPowerReceiver = false,
.enableLinMade = false,
.oversample = 8,
.enableMsbFirst = false,
.dataWidth = 8UL,
.parity = CY SCB UART PARITY NONE,
.stopBits = CY_SCB_UART_STOP_BITS_1,
.enableInputFilter = false,
.breakWidth = 11UL,
.breaklLevel = falss,
.dropOnFrameError = false,
.dropCnParityError = false,
.receiverAddress = 0x0UL,
.receiverAddressMask = 0x0UL,
.acceptAddrInFifo = false,

.enablaCts = falsa.

< >
Serial Communication Block (SCB) 1 (CYBSP_UART) - Parameters Code Preview

Figure 22 Code preview pane

3. Go to the Pins tab in Resource Categories pane to configure the GPIO connected to the user LED on the
kit. See Table 8 if you are using a different PSoC™ 4 kit. Configure the GPIO as shown in Figure 23.

Device Configurator - o X
File Edit Settings View Help
CYBC4149AZ1-5598 P7[3] (CYBSP_LED1, CYBSP_USER LED, CYBSP_USER_LEDT) - Parameters 8 x
Peripherals ~ Pins  Analog-Routing  System Peripheral-Clocks  DMA Enter flter te O YER
Ent TYEE A = LR K |Name Value
Resource Name(s) personalit, ~ | v Peripheral Documentation
© Port0 = (?) Configuration Help  Open GPIO Documentation
CYBSP_CSX_TP_RX0 Pin-2.0 v General
CYBSP.CX BTNRX 0 = (@ Drive Mode Strong Drive. Input buffer off ]~
CYBSP_SHIELDY PIn20 nitial Drive State  High (1) v
CYBSP_CSX_BTN1_TX Pin-2.0 < v (neud
hreshold -
CYBSP_DEBUG_UART_RX Pin-2.0 - ZMOS
CYBSP_DEBUG_UART_TX Pin-2.0 nterrupt Tigger Type {Hone
s [ v Output
CYBSP_DEBUG_UART CTS )
e & (@ slewRate Fast ~
CYBSP_DEBUG_UART_RTS s [
] — v Internal Connection
ol (?) Analog <unassigned>
CYBC4149A71-559 (100-T0F%) =
d { = igital Output <unassigned> v
?) Digital IOut <unassigned> v
v Advanced
?) Store Config in Flash
CYBSP_MSC1_CMOD1 Pin-2.0 ort-level Config [
CYBSP_MSC1_CMOD2 Pin-2.0
CYBSP_A13, CYBSP2_12
CYBSP_LEDT, CYBSP_USER LED, CYBSP_USER_LED1 | Pin-2.0 g Code Preview & x
Toss 0 port | o Enter search te)
CYBSP_A14, CYBSPI2 14 : - ~
®
CYBSP_CSX_TP_RX2 Pin-2.0 is & preview only. It combines elements of the
. cfg_pins.c and cycfg_pins.h files located in the fol
CYBSP_CSXTP_RX1 el o « Ci/mtw/Hello Morld/baps/TAR ®_CYBCKIT-0415-MAX/cox
v posiipe »
>
<
Notice List 8 x
Qotros | 0Warnings [ 0Tasks @0 imos
Fix Description Location

Ready

Figure 23 Configuring GPIO
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Table 8 Pin mapping table across PSoC™ 4 kits
Function CYSCKIT-145(PS | CYSCKIT-149(PS | CYS8CKIT-041S- | CYSCKIT-040T | CYSCPROTO-040
0oC™4000S) 0C™4100S Plus) | MAX(PSoC™ PSoC™ 4000T | T PSoC™4000T
4100S Max) CAPSENSE™ CAPSENSE™
Evaluation Kit | Prototyping Kit
User LED P2[5] P3[4] P7(3] P4[0] 1[0], 3[0]
4, Disable (i.e., uncheck) any other peripherals and pins that may have been enabled by default for the kit.
5. Other resources like power, frequency and clock can be configured in the System tab of the Resource
Categories Pane. Default Power settings are shown in Figure 24. For this design, no further changes are

required.

[& Device Configurator - X

File Edit Settings View Help

CY8C4149AZ1-S598 Power - Parameters & x

Peripherals  Pins  Analog-Routing  System | Peripheral-Clocks ~ DMA Ente . OYEE
Yy¥E®E 4 LR K |Name Value

Resource Name(s) Personality v Documentation
Debug Access-1.0 (@) SysPm API Reference

v RT0S
(2) System Idle Power Mode |System Deep Sleep

o (?) Deep Sleep Latency (ms) |0

v [Operating Conditions
2) VDDA Voltage mV) |5000

2) VDDD Voltage (mV) 5000

J) SYSCLK

il - v "Analog System
() AMUXBUS pump enable []

~ Input s 1 1 I

0 eco — 0
O EXTCLK srss_0_clock 0_ext_0 l
O o
2 MO
0 wco

Miscellaneous

PLL [ L

Notice List 8 x

@ockros | 1 owamings | [E]oTesks @)oimnfos

Fix Description Location

Ready

Figure 24 Configuring System Settings
6. Go to File > Save or press [Ctrl]+[S] to save the configuration and to generate the source code in the
GeneratedSource folder.

5.7 Write firmware

This design uses the CM0+ CPU of the PSoC™ 4 to execute two tasks: UART communication and LED control. The
CMO+ CPU uses the UART to print the “Hello World” message to the serial port stream and to make the user LED
on the kit blink.

If you are using the Empty PSoC™ 4 starter application, you can copy the code snippet provided in this section,
to the main.c file of the application project. If you are using the Hello World code example, the required files
are already in the application.

Firmware flow

This section explains the code in the main. c file of the application.

In this example, the CM0O+ CPU comes out of reset and performs resource initialization. It configures the system
clocks, pins, clock to peripheral connections, and other platform resources.

The clocks and system resources are initialized by the BSP initialization function. PDL functions are used to
configure and enable the UART peripheral. The UART prints “Hello World” message on the terminal emulator -
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the onboard KitProg3 acts as the USB-UART bridge to create the virtual COM port. An infinite FOR loop, with a
software delay, is used to toggle the user LED periodically.

Note that the application code uses BSP/PDL functions to execute the intended functionality.

+  cybsp_init()- This BSP function initializes the system resources of the device including but not limited to
the system clocks and power regulators.

+  Cy_SCB_UART_Init()- This PDL function initializes the SCB block for UART operation. A configuration
structure, CYBSP_UART_config, is used as a parameter for this function to configure the UART. This structure
is autogenerated by design.modus based on the applied configuration.

e Cy_SCB_UART_Enable()- This PDL function enables the SCB block for UART operation.
+  Cy_SCB_UART_PutString()- This PDL function places a NULL terminated string in the UART TX FIFO.

+  Cy_GPIO_Inv()- ThisPDL function sets a pin output logic state to the inverse of the current output logic
state.

«  Cy_SysLib_Delay()- This PDL function inserts a delay (specified in milliseconds).
Copy Code Listing 1 or Code Listing 2, as applicable, to the main. c of your application project.
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Code Listing 1 Code snippet with UART communication (main.c) (Use for all kits other than CYS8CKIT-040T)

/*******************************************************************************

* Include header files
******************************************************************************/

#include "cy pdl.h"
#include "cybsp.h"

/*******************************************************************************

* Macros
*******************************************************************************/
#tdefine LED_DELAY_MS (500u)

#tdefine CY_ASSERT_FAILED (eu)

/*******************************************************************************

* Function Name: main
3K 3k 3K 3k 3k sk 3k sk 3k sk 3k sk 3k ok 3k sk 3k 3k %k 5k %k 5k sk 5k sk 3K sk 3K sk 3K ok 3k sk 3k sk 3k sk 3k sk 3k ok 3k sk 3k 5k %k 5k %k 5k %k 5k ok 3k sk 3K sk 3K %k 3k ok 3k sk 3k sk 3k sk %k %k ok ok %k ok %k ck sk ok kkkk

* Summary:

* System entrance point. This function performs
* - initial setup of device

* - configure the SCB block as UART interface

* - prints out "Hello World" via UART interface

- Blinks an LED under firmware control at 1 Hz

* Parameters:

*  none
*

* Return:
* int

*

*******************************************************************************/

int main(void)

{
cy_rslt_t result;
cy_stc_scb_uart_context_t CYBSP_UART_context;
/* Initialize the device and board peripherals */
result = cybsp_init();
/* Board init failed. Stop program execution */
if (result != CY_RSLT_SUCCESS)
{
CY_ASSERT(CY_ASSERT_FAILED);

}
/* Configure and enable the UART peripheral */
Cy_SCB_UART_Init(CYBSP_UART_HW, &CYBSP_UART config, &CYBSP_UART context);
Cy_SCB_UART_Enable(CYBSP_UART_HW);
/* Enable global interrupts */
__enable_irq();
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/* Send a string over serial terminal */
Cy_SCB_UART_PutString(CYBSP_UART_HW, "Hello world\r\n");
for(;;)
{
/* Toggle the user LED state */
Cy_GPIO_Inv(CYBSP_USER_LED1_PORT, CYBSP_USER_LED1_PIN);
/* Wait for 0.5 seconds */
Cy_SyslLib_Delay(LED_DELAY_MS);
}
}
Initialize Clocks and
System Resources
Initialize and Enable
SCB UART Block
Print “Hello World”
onto UART Terminal
Toggle LED/GPIO
State
Delay 500 ms
I
Figure 25 Firmware flowchart
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Code Listing 2 Code snippet without UART communication (main.c) (Use for any kit including
CYSCKIT-040T)

/*******************************************************************************

* Include header files
******************************************************************************/

#include "cy pdl.h"
#include "cybsp.h"

/*******************************************************************************

* Macros
*******************************************************************************/
#define LED_DELAY_MS (500u)

#define CY_ASSERT_FAILED (eu)

/*******************************************************************************

* Function Name: main

3k 3k ok 3k ok 3k 3k 3k 3k 3k 3k 3k 3k 3k 3k 3k 3k 3k 3k 3k 3k 3k 3k 3k 3k 3k 3k 3k 3k ok 3k 3k 3k 3k 3k 3k 3k 3k 3k 3k 3k 3k 3k 5k 3k 5k ok 5k 3k 3k 3k 3k 3k 3k 3k 3k 3k 3k 5k ok 3k %k 3k %k %k 3k 3%k 3k 3k 3k %k 3k %k %k %k %k %k %k %k k

* Summary:

* System entrance point. This function performs
* - initial setup of device

* - Blinks an LED under firmware control at 1 Hz

*

* Parameters:

*  none
*

* Return:
* int

*
*******************************************************************************/
int main(void)

cy_rslt_t result;

/* Initialize the device and board peripherals */
result = cybsp_init();

/* Board init failed. Stop program execution */
if (result != CY_RSLT_SUCCESS)

{
CY_ASSERT(CY_ASSERT_FAILED);

/* Enable global interrupts */
__enable_irq();

for(;;)

{
/* Toggle the user LED state */
Cy_GPIO_Inv(CYBSP_USER_LED1_PORT, CYBSP_USER_LED1_PIN);

/* Wait for 0.5 seconds */
Cy _SyslLib_Delay(LED_DELAY_MS);
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This summarizes how the firmware works in the code example. For details, explore the source files.

5.8 Build the application

This section explains how to build the application.

1. Select the application project in the Project Explorer window and click the Build <name> Application
shortcut under the <name> group in the Quick Panel. It uses the selected build configuration and
compiles/links all projects that constitute the application.

2. The Console view lists the results of the build operation.

mitw - Eclipse IDE for MedusToolbox™ e ] X
File Edit Source Refactor MNavigate Search Project Run Window Help
i R - ® trOv R &g .o .| a 'w|@
i Pro.. ¥ % Deb.. ¥ Reg... & Peri.. ~ B [ README.md & main.c = & Outline ¢
- * Function Name: main -~ SR E N e %
« & Hello World o NSRS AR AP SRS BRI RER SRR AN RSSO RS NSRRI SO R LR SRR SRR u o pdlh
& Binaries . R . ) . U gybsph
5 Includes :-:_'t‘_l_ This function performs # LED_DELAY_MS
& bsps SCB block as UART interface # CY_ASSERT_FAILED
& build p * mainfvoid)
deps
= images PNy PR
e libs e
templates "
< main.c * Return:
LICENSE * int i
= < >
e Quic... Vari.. % Expr.. % Brea. B2 Console * Problems =i Progress 0 Memory #®Terminal E ki @>O¥ =0
Eclipse IDE for A COT Build (?nscﬂe [Hello_World] . —
ModusToolbox™ i SO W TR OO :
SR | .text | exeseeemee | 5788 |
) | .ARM.exidx | exeeeelssc | 8 |
| .copy.table | exeeeelsad | 12 |
| .zero.table | exeeeelshe | 8 |
| .ramVectors | ex2eeeeeee | 192 |
| .data | exzeeeeece | 148 |
| .noinit | exzeeee1ss | 32 |
| .bss | ©x2eeeel7s | 78 |
| .heap | ex20e081c4 | 31292 |
| .stack | ex2eee7cee | 1824 |
Total Internal Flash (Available) 393216
Total Internal Flash (Utilized) 5972
17:35:@8 Build Finished. @ errors, @ warnings. (took 4s.791ms)
| w
Figure 26 Build the application
If there are any errors, check the steps and make sure that you complete all required tasks.
Note: You can also use the CLI to build the application. See the "3.5.3 Use command line" section
in the ModusToolbox™ user guide. This document is located in the /ide_3.2/docs/ folder in the
ModusToolbox™ installation directory.
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5.9 Program the device

This section explains how to program the PSoC™ 4 device.

ModusToolbox™ uses the SWD protocol to program and debug applications on PSoC™4 devices. For
ModusToolbox™ to identify the device on the kit, the kit must be running KitProg3. Some kits are shipped with
KitProg2 firmware instead of KitProg3. ModusToolbox™ includes the fw-loader command-line tool to switch the
KitProg firmware from KitProg2 to KitProg3. See section 5.1.10 KitProg Firmware Loader in the ModusToolbox™
IDE user guide for more details.

If you are developing hardware on your own, you may need a hardware programmer/debugger; for example,
CY8CKIT-005 MiniProg4.

1. Connect the kit to the USB port of your computer
2. Select the application project and click the <application name> Program (KitProg3_MiniProg4)
shortcut under the Launches group in the Quick Panel. The IDE will select and run the appropriate

run configuration. Note that this step will also perform a build if any files have been modified since the
last build.
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&5 Project Explorer &2 4% Debug % Registers =, Peripherals
+ |££ Hello_World |

i Includes

= bsps

= build

= deps

= images

= libs

[ main.c

= LICENSE

L@ Makefile

[% README.md

=5 mtb_shared

i Quick Panel )=Variables &< Expressions ®e Breakpoints
P P

Eclipse IDE for
ModusToolbox™

- Start

= MNew Application

=4 Import Existing Application In-Place
& Search Online for Code Examples
& Search Online for Libraries and BSPs
F Training Material

% Refresh Quick Panel

- Hello_ World (APP_CYBCKIT-0415-MAX)
@ Build Application

# Clean Application
- Launches

4 Hello_World Debug (KitProg3_MiniProg4)

|G Hello=Wor|d Program {KitProg3=MiniProg4]|

% Generate Launches for Hello_World

Figure 27 Programming an application to a device

The Console view lists the results of the programming operation.
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B Console &2 [ Problems 0 Memory R % | B el SIS
<terminated > Hello_World Program (KitProg3_MiniProg4) [GDB OpenQCD Debugging] openocd.exe (Terminated 07-Jun-2021, 12:44:44 PM)

** Device acquired successfully

** Programming Started **

auto erase enabled

Info : ignoring flash probed value, using configured bank size

Info : Padding image section @ at 0x00002218 with 232 bytes (bank write end alignment)

Warn : Only mass erase available, erase skipped! (psocd mass_erase <bank_id>)

11%] [#4#

22%] [

34%] [HEHEHE

A5%)]  [HHHEHEHEE

S7%] [
68%] [
80%] [ Programming ]

[ 91%] [ Programming ]

[100%] [ 1 [ Programming ]

wrote 8960 bytes from file C:/mtw/Hello_World/build/CY8CKIT-@415-MAX/Debug/mtb-example-psoc4-empty-app.hex in ©.481933s (18.156 KiB/s)
** programming Finished **

** Program operation completed successfully **

Programming ]
Programming ]
Programming ]
Programming ]
Programming ]
Programming ]

[ Y )

Figure 28 Console - programming results

5.10 Test your design

This section describes how to test your design.
Once the programming is done, reset the kit and observe the LED blinking.

For kits having UART enabled, follow these steps to observe the "Hello world" being printed. This application
note uses Tera Term as the UART terminal emulator to view the results. You can use any terminal to view the
output. Skip these steps for CYSCKIT-040T kit as UART is not supported for this kit.

1. Select the serial port

Launch Tera Term and select the USB-UART COM port as shown in Figure 29. Note that your COM port
number may be different.

Tera Term: New connection x
O TCPIP myhost.example.com
History
27
[elnet
SSH SSH2
Other
AUTO
® Serial Port: COM47: KitProg3 USB-UART (COM47) -
OK Cancel Help
Figure 29 Selecting the KitProg3 COM port in Tera Term

2, Set the baud rate
Go to Setup > Serial port. Set the baud rate to 115200.
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Port:
Speed:
Data:
Parity:
Stop bits:

Flow control:

X
COM47 v i
New setting

115200 v|

8 bit - Cancel

none v

1 bit v Help

none v

Transmit delay
0 | mseclline

0 msecichar

Tera Term: Serial port setup and connection

Device Friendly Name: KitProg3 USB-UART (COM47)

Device Instance ID: USB\WID_04B4&PID_F155&MI_02\6&1F5FBB6

Device Manufacturer: Cypress
Provider Name: Cypress
Driver Date: 6-12-2018

Driver Version: 1.9.0.0

Figure 30

3. Reset the device

Press the reset switch on the (See Table 9 )PSoC™ 4 kit. A "Hello world" message appears on the terminal.
The user LED on the kit will start blinking.

Configuring the baud rate in Tera Term

Table 9 Pin mapping table across PSoC™ 4 kits for reset switch
Function CYSCKIT-145(PSo | CYS8CKIT-149(PSo |CYSCKIT-041S- CYS8CKIT-04 | CYSCPROTO-0
C™4000S) C™4100S Plus) MAX(PSoC™ 4100S | 0T PSoC™ 40T PSoC™
Max) 4000T 4000T

CAPSENSE™ | CAPSENSE™
Evaluation |Prototyping
Kit Kit

RESET SW1 SW2 SW1 SW1 SW1

Application note
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T COM4T - Tera Term VT — O X ‘

File Edit 5etup Control Window Help
Hello world
i

Figure 31 UART message printed from PSoC™ 4
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6 My first PSoC™ 4 design using PSoC™ Creator

This section:

+  Demonstrates how PSoC™ can be programmed to do more than a traditional MCU

+  Shows how to build a simple PSoC™ design and install it in a development kit.

+  Provides detailed steps that make it easy to learn PSoC™ design techniques and how to use PSoC™ Creator.

6.1

6.1.1

Before you begin

Have you installed PSoC™ Creator?

Download and install PSoC™ Creator from the PSoC™ Creator home page. Note that the installation of the
toolset may take a long time - see the PSoC™ Creator Release Notes for more information.

6.1.2

Do you have a development kit or prototyping kit?

Testing this design requires one of the kits listed in Table 10, which has an integrated programmer.

Table 10 List of PSoC™ 4 pioneer kits, prototyping kits, and supported Devices

Kit name Kit type Supported device family Part number
CY8CKIT-040 Pioneer kit PSoC™ 4000 CY8C4014LQl-422
CY8CKIT-042 Pioneer kit PSoC™ 4200 CY8C4245AXI-483
CY8CKIT-044 Pioneer kit PSoC™ 4200M CY8C4247AZI-M485
CY8CKIT-046 Pioneer kit PSoC™ 4200L CY8C4248BZ1-L489
CY8CKIT-042-BLE Pioneer kit PSoC™ 4200 Bluetooth’ LE CY8C4247LQI-BL483
CY8CKIT-045S Pioneer kit PSoC™4500S CY8C4548AZ1-S485
CY8CKIT-043 Prototyping kit PSoC™ 4200M CY8C4247AZI-M485
CY8CKIT-145 Prototyping kit PSoC™ 4000S CY8C4045AZI-5413
CY8CKIT-147 Prototyping kit PSoC™ 4100PS CY8C4145LQI-PS433
CY8CKIT-149 Prototyping kit PSoC™4100S Plus CY8C4147AZI-S475
6.1.3 Want to see the project in action?

If you do not want to go through the design process, you can get the completed PSoC™ Creator project using
Find Code Example in PSoC™ Creator (File > Code Example... > CE230991_My_First_Project). You can then
jump to the Build and Program steps.

6.2 About the design

This design simply blinks two LEDs using a TCPWM Component, as shown in Figure 32.The TCPWM is configured
in PWM mode. The two complementary outputs of this PWM control the LEDs. The PWM operates at a very low
frequency and 50 percent duty cycle so that the toggling of the LEDs is visible. If you use a dual-color LED
instead of two separate LEDs, this project can toggle the color of the dual-color LED.
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Vdd

PWM_1

PWM
oV
un - %
cc

__LED 1

—=—1[1]

LED1RX
LED2 KX

R1

1K
R2
YAYAYA
1K

line -
line n — LED 2

it U[B]

Clock_1[AR}l  —>clock —

800 Hz interrupt

Period =254
Compare = 127

Figure 32 My first PSoC™ 4 design

6.3 Part 1: Create the design

This section takes you on a step-by-step guided tour of the design process. It starts with creating an empty
project and guides you through hardware and firmware design entry.

1. Start PSoC™ Creator, and from the File menu choose New > Project, as shown in Figure 33.
File | Edit View Project Build Debug Jools Window
New *[..] Project... "
Open » | T) Eile...
Code Example ... ! I X
!
Close Ctrl+F4  peEN
Figure 33 Creating a new project
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2, Select your development kit in the pop-up window. For example, if you have a CYS8CKIT-149, select Kit:
CY8CKIT-149 (PSoC™ 4100S Plus) and click Next. If you do not see your PSoC™ 4 development kit listed
in the menu, download and install the kit setup for your kit from the website.

Alternately, you can also select the target device radio button instead of the target hardware and select
the appropriate device and click Next.

Create Project - CYBCKIT-149 (PSoC 41005 Plus) ? >
Select project type
Choose the type of project — design, library, or workspace.

Design project:
(@ Target kit: CYBCKIT-149 (PSoC 41005 Plus) v

() Target module:
(O Target device:
(O Library project

(O) Workspace

Mext = Cancel

Figure 34 Create a new empty PSoC™ 4 project
3. Select the option Empty Schematic from the next window and click Next.
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Create Project - CYBCKIT-149 (PSoC 41005 Plus)

Select project template
Choose a schematic template or start your design with a kit or example project.

a1n1] |Code example
oo10| |Choose from our library of code examples.

Pre-populated schematic

Start with typical MCLU functions (ike UART, ADC, etc.).

Empty schematic

(| 6E) [E

Create a full custom design by adding functionality from the component catalog.

Cancel

Figure 35

Select empty schematic

4, Provide a project name (for example, "My_First_Project") and Workspace Name as shown in Figure 36.
Choose an appropriate location for your new project, and click Finish.
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Create Project - CYBCKIT-149 (PSoC 41005 Plus) ? .t

Create Project

Choose a name and location for your design.

Create new workspace

Workspace name: |My_Workspace

Location: C:\Projects
Project name: My _First_Project
< Back Finish Cancel
Figure 36 Selecting project name and location

5. Creating a new project generates a project folder with a baseline set of files shown in the Workspace
Explorer (see Figure 37). To open the project schematic file, double-click TopDesign.cysch.
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'Workspace Explorer (1 project)
|54 g
= Workspace 'My_Workspace' (1 Projects)

= Pa| Project My First Project’ [CYBC4147AZI-5475]
I_}:r TopDesign.cysch
= _]9 Design Wide Resources (My_First_Project.cydwr)

\tﬁ Pins

-(® Clocks

;,f Interrupts

-89 System

‘!’=— Directives
. @] Flash Security
=H) Header Files
- i|n] cyapicallbacks.h
=HL Source Files

1
E=
X

uogejuawniog | speuodwon {aa.mus e

. =
€] main.c ]
c
o
Figure 37 Opening TopDesignh schematic
6. Drag one PWM (TCPWM mode) Component from the Component Catalog onto the schematic, as shown
in Figure 38.
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Component Catalog (154 components) « 3 X
PN
:T’h Search for

q b

/ .(ypress] Off-Chip

i Cypress Component Catalog

%8 Analog

l:t}ﬂ CapSense

L-,r_r&g Communications

E%g Digital

E}ﬂ Functions

. i-[o] Counter[v3.0]
i-[8] CRC [v2.50]
i-[8] PriSM [v2.20]
--[9] PRS [v2.40

119 PWM [v3.30]

../0] Shift Register [v2.301

i‘{} Quadrature Decoder (TCPWM m
- ¢] Quadrature Decoder [v3.0]

Location of the PWM Component

Double-click the PWM Component on the schematic to configure the Component properties, as shown in
Figure 39. Click the PWM tab, and set the Period value to 254 and the Compare value to 127 to generate

a PWM signal with a 50 percent duty cycle.
Set the Prescaler to 8x, to divide the input clock frequency by 8.
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Configure 'PWM_T’

Name: PWM_1

Configuration /~ PWM } Built-in

4 b

Intemupt
On terminal count

[] On compare/capture count

Prescaler: I 8 ~ Input

PWM align: Left align v reload

PWM mode: PWM v I
stop

Dead time cycle: = switch

Stop signal event: Dont stop on kill count

Kill signal event: Asynchronous v

Output line signal: Direct output v Periad

Output line_n signal: Direct output v Compare

Register Swap RegisterBuf

Present Mode

[] |Rising edge
[l |Rising edge
[] |Rising edge
[] |Rising edge
] Level

254 |
127 |

65535
65535

Datasheet

PWM, left aligned

Cancel

Figure 39 Configuring the PWM Component
8. A PWM Component requires an input clock for its operation. Drag and drop a Clock Component onto
the schematic, and configure the Frequency to 800 Hz by double-clicking on the Component, as shown
in Figure 40 and Figure 41. Because the Prescaler value set in PWM Component is 8, the effective input
clock of the PWM is only 100 Hz. Therefore, the PWM period of 254 results in a PWM output time period of

2.54 seconds.
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(infineon

Component Catalog (105 componen... » 8 X
| e

ﬁ Search for.

_/Evpressl Off-Chip q b
(il Cypress Component Catalog
'E Analeg
89 CapSense
[ @8 Communications
@4 Digital
[+-%g Display
“ Ports and Pins
'ﬁ Power Supervision
E}-ﬂ System
. (2] Bootloadable [v1.60]
/9] Bootloader [v1.60]
E
r -|@] Die Temperature [v1.0]
- ¢] DMA Channel [v1.0]
--[¢] Emulated EEPROM [v2.20]
%8 External Memory Interface
;_I} Global Signal Reference [v2.10]
9] Interrupt [v1.70]
..[¢] Real-time clock (RTC) [v1.30]

-ﬂ Thermal Management

Application note

Figure 40 Location of the clock Component
Configure 'Clock_1'
Name:  [Clock_1
Basic Built-in
Clock type: ® New O Esting
Source: |o=u|os
Specify: Iﬁm: 800 He ~
[ Toterance: - [5% |+ [54
[ Use fractional divider
AP Generated: Yes
Uses Clock Tree Resource: Yes
By defaul, 3l clocks are marked as stat on reset”. The setting can be changed in the Design Wide Resours
Figure 41 Configuring the clock Component
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9. Drag and drop a Digital Output Pin Component. Change the name to LED_1 as shown in Figure 42 and
Figure 43. Add another Digital Output Pin Component and change its name to LED_2.

Compenent Catalog (105 componen... - -nx|
W e
.ﬁ Search for..

___,-f”gtvprﬁs} Off-Chip 4 b
ﬂ Cypress Component Catalog
3@ Analog
L-‘;r} &8 CapSense
@88 Communications
%9 Digital
i +1- %8 Display
U ﬁ Ports and Pins
o j Analog Pin [v2.20]
3 Digital Bidirectional Pin [v2.20]
-2 Digital Input Pin [v2.20]
- [ 2 Digital Output Pin [v2.20]]
lﬁ Power Supervision
%8 System
-8 Thermal Management

Figure 42 Location of the digital output pin Component
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/| HW connection
Digital output

HW connection

[] output enable
[] Bidirectional

HX [] Extemal teminal

<

$

-

Configure 'LED_1" ? K
Name: [LED_1 |
_/"Pins | Mapping | Clocking | Buit-n | qp
Number of pins: |1 |>< L 'l'l %
(A pins] | General | Input | Output |
X [EDila Type Drive mode Initial drive state:
[ Analog Strong dive v| [He@)
[] Digttal input e Min. supply voltage:

Ein

Z

Apply

Cancel

Figure 43 Renaming a pin Component

10. Inthe schematic window, select the wire tool as shown in Figure 44, or press W.

A
Wire Tool (Hot Key: W)
Single-click this button f

< Double-click this button

Figure 44 Selecting the wire tool
11. Wire the Components together, as shown in Figure 45.
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PWM_1
PWM

oV H

un p-

CC |+
line |- —={«]LED_1
line_n |- — o] LED_2

Clock_1[JR}- —> clock
800 Hz interrupt (=
Period =254

Compare = 127

Figure 45 Wiring the schematic
12. Most Components are disabled at device reset (the major exception being the Clock Component, which
is automatically started as a default), and you must add code to the project to enable them. Open main.c
from Workspace Explorer and add code to the main() function, as provided in Code Listing 3.

Code Listing 3 Enabling the PWM Component

int main(void)

{
/* Enable and start the PWM */
PWM_1_Start();

for(5;)
{

}
}

13.  Select Build My_First_Project from the Build menu. Note that PSoC™ Creator automatically generates
source code files in the Workspace Explorer window for the PWM, Clock, and Digital Output Pin
Components, as shown in Figure 46.
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‘Workspace Explorer (1 project)
@
ﬂ Workspace "My_Workspace' (1 Projects)
= P3| Project ‘My_First_Project’ [CYBC4147AZI-S475]
LE_Q' TopDesign.cysch
= _-P Design Wide Resources (My_First_Project.cydwr)
: H \& Pins
-0\, Analog
(3 Clocks
. #F Interrupts
¥ System
--/&) Directives
. @] Flash Security
=+ Header Files
. i h] cyapicallbacks.h
i=HL Source Files
g maing
ERie ] Generated_Source
EHED PSoC4
B Clock_1
L i-[g] Clock_1.c
th] Clock_1.h
--.1_"] cy_boot
B cy_dmac
BHED cy_lfclk
c3 Em_EEPROM_Dynamid
EHE LED1
. b[) LED 1c
.-[n] LED_1.h
~-|n] LED_1_aliases.h
. L[¢) LED_1_PM.c
- LED 2
EHE PWM_I
L e] PWM_1.c
--[n] PWM_1.h
L ele] PWM_1_PM.c
_‘j cycodeshareexport.id
i ] cycodeshareimport.ld

Figure 46 Generated source files

14. OpenthefileMy_First_Project.cydwr (Design-Wide Resource file) from Workspace Explorer and click
the Pins tab. You can use this tab to select the device pins for the outputs LED_1 and LED_2.
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Figure 47 shows the pin configuration to connect the LED_1 and LED_2 pins to the LEDs in the
CY8CKIT-149 PSoC™ 4 prototyping kit. See Table 11 if you are using a different PSoC™ 4 pioneer kit, or
Table 12 if you are using a PSoC™ 4 prototyping kit.

. "My_First_Project.cydwr | -4 b x
é . Name Port Pin Lock
|§|~3‘___ﬂﬂ_‘_:' [/ 1ep_1 P1[6] * |64 v ]
‘:_f§§§ffff§,;§:::éﬁ [/ 2z 2 Bs(7] - |36 M v
2 | CYBC4147AZI-S475
o R 64-TQFP
o
—Eu
< pins | M\ Analog | (&) Clocks | #* Interrupts | B System | & Directives | () Flash Security ab
Figure 47 Pin selection
Table 11 Pin mapping table across pioneer kits
Funct | CYSCKIT-04 | CYS8CKIT-04 | CYSCKIT-04 | CYSCKIT-04 |CYS8CKIT-04 | CYS8CKIT-04 | CYSCKIT-04
ion 0 (PSoC™ 1(PSoC™ 2(PSoC™ 2- 4(PSoC™ 6(PSoC™ 5S(PSoC™
4000) 4100S) 4200) BLE(PSoC™ |4200M) 4200L) 4500S)
4200 BLE)
Green | P1[1] P2[6] P0O[2] P3[6] P2[6] P5[3] PO[0]
LED
(Activ
e
LOW)
Red |P3[2]Y P3[4]1% P1[6] P2[6] PO[6] P5[2] P1[6]
LED
(Activ
e
LOW)
Table 12 Pin mapping table across prototyping kits
Function CYS8CKIT-145 (PSoC™ 4000S) CYSCKIT-149 (PSoC™ 4100S
Plus)
Green LED - LED 1 (Active LOW) P3[4] P1[6]

(table continues...)

PSoC™ 4000 parts have fixed pins for complementary PWM outputs - P1[1] and P1[6]. You cannot use any other pins for PWM

outputs. See the device datasheet for more details. If you are using the CY8CKIT-040, you can use the green LED connected to
P1[1], as LED1. To use the red LED as LED2, connect P3[2] from header J4 to P1[6] from header J3, using a wire. Alternately, you

can connect an external LED to P1[6] as LED2.
Similar to the note above, if you are using the CY8CKIT-041, you can use the green LED connected to P2[6], as LED1 and the

10

complementary PWM output P2[7] for LED2. To use the red LED as LED2, connect P3[4] from header J2 to P2[7] from header J3,
using a wire. Alternately, you can connect an external LED to P2[7] as LED2.
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Table 12 (continued) Pin mapping table across prototyping kits

Function CY8CKIT-145 (PSoC™ 4000S) CYSCKIT-149 (PSoC™ 4100S
Plus)

Green LED - LED 2 (Active LOW) P3[5] P5[7]

15.  Finally, rebuild the project as explained in Step 13.

6.4 Part 2: Program the device

This section explains how to program the device. Connect the kit board to your computer using the USB cable.
1. Select the PSoC™ Creator menu item Debug > Select Debug Target, as shown in Figure 48.

| Debug Tools T_'l.’indnw Help
Windows ]
Eﬂ Program Ctri+F>
'ﬂ Select target and program...
[ 3% Select Debug Target...

#% Debug F5

s

#%& Debug without Programming  Alt+F5

% Select target and debug...

Figure 48 Selecting debug target
2, In the Select Debug Target dialog box, click Port Acquire, and then click Connect, as shown in Figure
49, Click OK to close the dialog box.
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Select Debug Target ? e
E-3 KitProg3 (CMSIS-DAP/BULK/1B110F23012A8400) PSoC 41005 Plus CYBCA4147AZ1-5475

¢ PSoC 41005 Plus CYSC414TAZI-5475 PSoC 4100S Plus (CortexM0p)
Silicon ID: (x0BC11477

Cypress |D: (x257C12B5
Revision: PRODUCTION

Target unacquired

Show all targets v

I OK / Connect

Figure 49 Connecting to a device
3. Choose the menu item Debug > Program to program the device with the project, as shown in Figure 50.

éﬂebug | Tools Window Help

| Windows »
||uI Program Ctri+F5
iw Select target and program...

iﬁ Select Debug Target...

Figure 50 Programming the device
4, You can view the programming status on the status bar (lower-left corner of the window), as shown in
Figure 51.
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1 I
[
. Page 1 |

‘lPngramming - Erasing... I

Figure 51 Programming status
5. After the device is programmed, ensure that the LEDs toggle, and confirm the working operation of the
project.
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7 Summary

7 Summary

This application note explored the PSoC™ 4 architecture and development tools. PSoC™ 4 is a truly
programmable embedded system-on-chip, integrating configurable analog and digital peripheral functions,
memory, and an Arm’ Cortex -M0/MO0+ microcontroller on a single chip. Because of the integrated features and
low-leakage power modes, PSoC™ 4 is an ideal choice for low-power and cost-effective embedded systems.

This application note also guided you to a comprehensive collection of resources to accelerate in-depth
learning about PSoC™ 4.
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Trademarks

The Bluetooth” word mark and logos are registered trademarks owned by Bluetooth SIG, Inc., and any use of
such marks by Infineon is under license.
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note must verify any function and other technical
information given herein in the real application.
Infineon Technologies hereby disclaims any and all
warranties and liabilities of any kind (including without
limitation warranties of non-infringement of intellectual
property rights of any third party) with respect to any
and all information given in this application note.

The data contained in this document is exclusively
intended for technically trained staff. It is the
responsibility of customer’s technical departments to
evaluate the suitability of the product for the intended
application and the completeness of the product
information given in this document with respect to such
application.

Warnings

Due to technical requirements products may contain
dangerous substances. For information on the types
in question please contact your nearest Infineon
Technologies office.

Except as otherwise explicitly approved by Infineon
Technologies in a written document signed by
authorized representatives of Infineon Technologies,
Infineon Technologies’ products may not be used in
any applications where a failure of the product or
any consequences of the use thereof can reasonably
be expected to result in personal injury.
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